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Overview 

What is NEO Pro 

A new way to think about email 

If you’ve been struggling to organize your email, it’s no wonder. As email piles up in your 
Inbox you soon become swamped – if you organize by folder you’re continually filing 
messages, and if you don’t, you can’t find messages when you need them. 

The problem with email programs is they shoehorn you into an Inbox/folder mentality – 
they only show your messages in one way. You can filter them but you can’t easily view 
the same messages in different ways. 

Think of NEO Pro as an intelligent email sorter. It automatically organizes your email in all 
the ways you think about email – by date, by correspondent, by mailing list, by 
attachment, and so on. 

Finding messages is a breeze 

Your messages automatically appear in more than one location at the same time. That 
makes finding them much, much easier, and when you do need to search, our search is 
lightning fast. 

Companion product for Microsoft Outlook 

Nelson Email Organizer is a companion product for Microsoft Outlook 97, 98, 2000, 
2002(XP), 2003, 2007 and 2010. It works with the Internet mail only, corporate and 
workgroup, and Exchange Server platforms. 

NEO Tutorials 

Getting to know NEO Pro using our online tutorials is time well spent. There are several 
bite-sized videos to choose from. We suggest you start with the NEO Primer.  

http://www.emailorganizer.com/products/webinars_tutorial.php 

How NEO Pro Works with Microsoft Outlook 

NEO is an add-on product to Microsoft Outlook and works with Outlook 97, 98, 2000, 
2002, 2003, 2007, 2010 and Exchange Servers 5.5, 2000, 2003, 2007 and 2010. 

Alternative interface for your email 

NEO Pro is an alternative interface for the email component of Outlook. NEO Pro is not 
intended  to replace the other features of Outlook. You can easily switch between NEO 
Pro and Outlook, and interact with some components of Outlook. 

Although you must have Outlook installed, you don’t have to have Outlook open to use 
NEO Pro. 
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Using Outlook features from NEO Pro 

Wherever practical, NEO Pro was designed to work the same as complementary features 
in Outlook. You can compose, reply, reply all, forward, send/receive, mark read, and so on 
- the usual message actions – all from within NEO Pro. 

Here are Outlook actions you can take from within NEO Pro: 

•         Switch quickly to Outlook , or switch to an area in Outlook such as contacts, calendar (see 
the Outlook command on the NEO Pro toolbar). 

•         Open a new item in Outlook  such as a new appointment (see the New dropdown on the 
NEO Pro toolbar). 

•         Open the Outlook contact record  for any NEO Pro Correspondent , or create a new one 
(right-click any message or name folder). 

•         Drag and drop messages  to non-email Outlook folders such as contacts and journal. 

NEO Pro also depends on some settings configured in Outlook. 

Same message store 

Your email messages are not duplicated in NEO Pro – the messages remain stored in 
your Outlook or Exchange Server message stores. 

Like Outlook, NEO Pro interfaces with your underlying message stores. When messages 
arrive into your message store, NEO Pro is notified. When you send or delete messages 
from NEO Pro, your message store is updated in exactly the same way it is when you 
send or delete from Outlook. 

Indexing and the Catalog 

NEO Pro works by creating indexes to your messages and storing the indexes in a 
separate NEO Pro catalog. Whenever messages are sent, received or updated in the 
message store, NEO Pro automatically updates the indexes in the catalog.  

Normally you would include all your message stores in a catalog. 

How NEO Pro works with Exchange Server 

NEO Pro works with Microsoft Exchange Server mailboxes. 

However, NEO Pro is an email organizer. It does not organize other Outlook object types 
such as calendar items, journal items, and note items although it does provide ways to 
interact with them. 

Here are some notes about using NEO Pro with Exchange Server: 

NEO Pro is a client-side product 

That means NEO Pro installs and operates completely on your computer. There is nothing 
about NEO Pro that gets installed on the server or that is related to Exchange Server. In 
fact, Exchange Server is completely unaware of NEO Pro. 

You can organize your Mailbox and your PSTs 

You can include your mailbox and as many PSTs as you like in your catalog. NEO Pro will 
give you a seamless view to all your messages. NEO Pro makes it appear as though it's 
all in your Mailbox. 
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Using your offline message store (OST) 

When using Offline mode or Cached Exchange Mode it is best to delete messages from 
within NEO Pro. If messages are deleted outside of NEO Pro (in Outlook or via an Outlook 
Rule), they may not disappear from NEO Pro until a Full Sync is performed. 

Offline mode using Outlooks prior to Outlook 2003 

If you have offline access enabled (you use an offline message store), you should select 
all  your email folders for OST/Mailbox synchronization. In addition, you should not  set 
filters for your folders. 

You will not lose messages when you do this; however, if you do not include all your 
folders NEO Pro may spend quite a bit of time removing and adding messages in the 
catalog each time you switch between your OST and your mailbox. 

If you have instructed Outlook to automatically Outlook synchronize your Exchange 
mailbox with your OST when exiting an online session, you must shut down Outlook 
without NEO Pro running for the synchronize to be performed. 

Cached Exchange Mode 

NEO Pro works normally with Cached Exchange Mode.  

Reminder – Synchronize each time you re-connect to t he LAN 

Whenever you re-connect to the LAN, you must synchronize to update NEO Pro with new 
messages from your mailbox. Note that you can configure NEO Pro to automatically Fast 
Sync on startup, or get general information about syncing.  
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Getting Started 

What's New in the latest version 

For what’s new in the latest version of NEO Pro, please see our What’s New for full 
details. 

Ways to start NEO Pro  

It's best to start Outlook first and keep it runnin g 

NEO will normally perform better if you start Outlook before NEO starts and if you keep 
Outlook running while NEO is running. Otherwise, some Outlook features and some add-
ins such as anti-virus tools may not perform properly. 

For those not using Outlook actively, this may seem to be a waste of memory. However, 
having Outlook running only minimally increases your memory usage over not having it 
running because when not running NEO must open and work with a hidden copy of 
Outlook anyway. Note that Outlook can be minimized, and that it can be moved to the tray 
when minimized (for Outlook versions supporting that feature). 

If you know you don't use other Outlook add-ins or anti-virus programs that depend on 
Outlook, then feel free to use NEO without starting Outlook first. 

Start NEO automatically when you start Outlook 

This is the recommended  approach. Enable the option to automatically start NEO when 
Outlook starts (see the Startup options on General Options), then always start NEO by 
starting Outlook  (which will then automatically start NEO). 

Start NEO manually 

After Outlook has started (recommended), you can also start NEO manually as you would 
any application: 

o   Click NEO from Start | Programs. 

o   Double-click the NEO icon on your desktop 

o   Two special ways to start NEO: 

o  Hold down the Shift key when double-clicking (and holding it down while NEO starts) 
will start NEO without opening a catalog. 

o  Hold down the Ctrl and  Shift keys when double-clicking (and holding it down until the 
confirmation appears) clears user interface settings such as Workspace Layout and 
Toolbar configurations, but not your Options or any catalog-related information (e.g., 
Correspondent names).  

Starting NEO with a specific Catalog by using a com mand line option. 

You can start NEO with a command line option to open up a specific catalog. For 
example, you could then open more than one catalog without having to choose from the 
File menu. 

The best way to do this is to create a separate desktop shortcut: 
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1. Using Windows Explorer locate the program file for the NEO version you are running. This will 
be in the folder you installed NEO into (probably c:\Program Files\NEO ...) and will be 
NeoPro.exe.  

2. Right-click drag the file onto your desktop. When you drop it choose Create Shortcuts Here. 

3. Close Windows Explorer. Right-click the shortcut you just created, and choose Properties on 
the shortcut menu. 

4. On the Shortcut tab, locate the Target box. It contains the path for the exe file. Put your cursor 
at the end of the field. 

5. Press the SPACEBAR once to type a space after the path, and then type -o Catalog Name.  
Note that you must enter this at the end of the target field. A sample target might look like this 
"C:\Program Files\NEO Pro\NeoPro.exe" -o My Other Catalog. Note that the quotes are 
important. 

6. Click OK. 

Start NEO from Outlook 

Click Go to NEO on the Tools menu in Outlook, or click the NEO icon on the Outlook 
toolbar. 

Start NEO automatically when you start your compute r 

Locate your Windows Startup folder and copy the NEO desktop icon to it.  

Note :    If you want NEO messages to be automatically synchronized with your Outlook 
messages, you must always have NEO open when you have Outlook open.  

Get help from within NEO  

Help is available from within NEO via: 

Tool tips         For a short description of toolbar commands and other command 
buttons, roll your mouse over the command. A tool tip will appear in 
about one second. 

Questions       Also available on the Help menu, Common Questions are answered.  

Shortcuts        Also available on the Help menu, its worth learning Keyboard Shortcuts 
for actions your perform often.  

Symbols         Familiarize yourself with the icons and symbols in the Reference 
section at the end of this document.  

Help system     Press F1 or watch for "more info" and Help buttons inside NEO.  

If you are new to NEO, be sure to see all the items in the Getting Started section. After 
you have used NEO for a while, you may want to visit the Productivity Tips section.  

Support and Feedback 

Click Get Support  on the Help menu. 
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Things to do each day 

Outside of your normal sending and receiving messages, here are the things you should 
bring into your daily workflow. 

1. If you use  automatic Bulk Mail assignment ( default is ‘off’ ), clear out your Unsorted 
Bulk Mail 
When automatic Bulk Mail assignment is ‘on’, NEO identifies new bulk mail and puts it here. If 
you don't use the Correspondent filter to filter out Bulk Mail it will also arrive in your Inbox and 
can be managed from there too. However, if you do use the Correspondent filter, be sure to 
check this folder daily because the filter will prevent this mail from appearing in your Inbox. 

2. Empty your Spam Senders folder  
If you block spam senders, you need to go to your Spam Senders folder in Bulk Mail view to 
view and empty it from time to time. 

3. Empty your Deleted Messages folder  
When messages are deleted from NEO they go into the Deleted Items folder in Outlook view. 
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Productivity Tips 

Being Productive 

You’ll get the most out of NEO if you rely on its automated features to do most of your 
organizing for you. With that base, you can then use other NEO features such as filters to 
help you focus on the messages you need to. 

NEO Application Notes 

To help you implement the most efficient way of working please refer to our Application 
Note on implementing time-management compliant workflow principles. You will find this 
Application Note here: http://www.emailorganizer.com/kb/T1165.php.  

Our Online Email Training 

To boost your email efficiency and for a guided step-by-step implementation of the most 
efficient way to manage your emails, please subscribe to our Online Email Training. More 
information here: http://www.emailorganizer.com/training/training.php. .  

An Introduction to NEO Pro 

Use NEO Pro to create and send mail just as you would with Outlook. Here are a few 
things to help get you on your way with NEO Pro. 

 
   First, get oriented by clicking each of the Viewtab s 

 

For your favorites. Make an Outlook or NEO 
folder hot. Most popular view. 

 

Manage your Outlook folders here just as 
you would in Outlook's Folder List. 

 

All your regular mail is automatically 
organized into Correspondent folders for 
you. 

 

For your e-newsletter type email. New Bulk 
Mail goes into the Unsorted Bulk Mail folder. 
Create your own Bulk Mail folders from 
there. Bulk Mail can also be assigned based 
on the subject. 

 

Automatically organized by your Outlook 
categories. Easy to edit and manage. 

 

A folder containing all messages in each 
state: Unread, Flagged, ToDo, Active, 
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Important, .. 

 

Date folders: Today, Yesterday, This Week, 
.. Dec 1999, Jan 2000, .. Feb 2006, Mar 
2006, .. 

 

All your attachments auto-organized into 
folders by attachment type (e.g., DOC, XLS, 
PDF, ..). 

 

Enter your search words and NEO 
automatically searches across all your 
folders. 

 
   How NEO works  

  

NEO extends Outlook capabilities in many ways, but there's one feature  of NEO that's worth 
knowing: 

  

Virtual 
folders  

NEO displays the same message in different ways.  
    

 

They are displayed in their Outlook folders and in all the 

virtual folders that NEO Pro automatically creates for you. 

One more thing: don't worry about trying to understand all of NEO right away. Over time you 
will discover new things you can do. 

 
   Note you can continue to use Outlook just as before  

  

 

Click the Outlook  button on 
the View tab to jump to 
Outlook.  

Or double-click any of the 
following in your NEO 
Outlook view. 

 

To return to NEO, click 
 on the Outlook toolbar. 
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Ways to use NEO 

Using email involves managing  messages and finding  messages.  

Here are three ways to manage messages  with NEO: 

   Stay on top of your incoming mail  

Like Outlook, all new mail comes into your Inbox. However, with NEO: 

• Messages are much easier to find - there's less (no) need to file to specific folders. 
Using NEO Pro you can easily use a single large archive folder 

• Keep your Inbox small. You can use it for your To Do or you can use NEO’s To Do 
folder for your To Do’s - messages you still have to take action on. 

Ok, so how do you keep your Inbox small without the  hassles of filing?  

The key is how you file . In NEO you can quickly move messages out of your 
Inbox. You can file to your recently filed-to folders, and you can file to a single 
'quick file' folder that you designate - perfect for messages you don't want to 
think about where to file (after all, isn't that where most of the filing frustration 
comes from … deciding where to file a message). 

Turn your Inbox into your To Do : file messages you are finished with but want 
save, and leave in your Inbox messages still requiring action.  

Or, empty your Inbox by using NEO’s To Do : assign messages still requiring 
action NEO’ To Do flag (high, medium or low priority) and move them also out of 
your inbox.  

Use Quick File to keep your Inbox small  

Click Quick File  on the toolbar to file to your designated Quick File folder, or 
click Quick File Recent  on the toolbar to choose from other recently filed-to 
folders. Pressing Backspace  will also bring up your Quick File Recent menu.  

It all comes down to two easy keys - Delete, Backspace:  

             

Remember:      Backspace doesn't delete the message!  It just helps you file the 
message to another Outlook folder, so you can keep your Inbox 
small. 

In NEO Pro, there are other organizing things you can do with messages such 
as Keeping messages and Categorizing messages.  

Flexible filing to any folders  

As with Outlook, you can also file by dragging to folders, using File to Folder, or 
Outlook Rules.  

   Focus on your priority mail  



P a g e  | 18 

Bring forward your Correspondent mail  

You can let NEO automatically  separate your regular Correspondent mail from 
your Bulk Mail (e.g., e-newsletters).  

If so you can choose when to just see your Correspondent mail, your Bulk Mail 
or both. Most NEO users just want to see Correspondent mail during the 
business day, and see their Bulk Mail at specific times such as first thing in the 
morning.  

 

On the Filter tab, click icons to show just Correspondent or 
Bulk Mail messages respectively. 

Zero in on folders with Unread messages  

You can also filter NEO to just see folders that contain unread messages.  

 

The ‘Folders with Unread messages' filter is especially 
helpful in Correspondent view but applies to Bulk Mail and 
Outlook folders too. 

Notice that when a filter is set the background color changes to let you know a 
filter is active (you can change the filter background color). To clear the filters, 
unclick them.  

   Things to do each day - or at least often  

Outside of your normal sending and receiving messages, here are the things you 
should build into your daily workflow. 

1.   When using automatic Bulk Mail assignment ( default is ‘off’ ), check your 
Unsorted Bulk Mail folder  

You can let NEO identify new bulk mail automatically which puts it in the 
Unsorted Bulk Mail folder. If you don't use the Correspondent filter to filter out 
Bulk Mail you'll set it in your Inbox and can be managed from there too. 
However, if you do use the Correspondent filter, be sure to check this folder 
daily  because the filter prevents this mail from appearing in your Inbox.  

By default NEO will place all new Bulk Mail under Correspondent folders so you 
can do the Bulk Mail assignment manually yourself. 

2.   Empty your Spam Senders folder  

If you block spam senders, you need to go to your Spam Senders folder in Bulk 
Mail view to view and empty it from time to time.  

3.   Empty your Deleted Items folder  

When messages are deleted from NEO they go into the Deleted Items folder in 
Outlook view.  
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Finding Messages Quickly 

Conversation View 

 

 

All messages can be viewed within their e-mail thread. 
To enable click the Conversation  View  button on the 
Quick Access Toolbar or on the View Tab. 

 

Search for a message using the Search entry box 

 

Enter a search word into the Search entry box which is available in all views above 
the message listing. Press Enter (or click the left icon) to search through all 
message stores or press Shift+Enter (or click the right icon) to search only in the 
current folder. 

Search for a message using the Search tab 

 

Click the New Search  button on the ribbon 
(Shift+Ctrl+F). Enter the search term and press Enter 
or click Go. 

 

  

You can use 
logical operators 
like and , or  and 
near . 

Or change options 
or parameters to 
limit your search 
such as searching 
within a folder. 
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Search on Conversation ( alternative for Conversation View ) 

 

To find the conversation for a single message, highlight the 
message (e.g., with subject ‘Marketing Plan’) then click the 
Search on Conversation  button on the ribbon (Ctrl+Alt+F) to 
find all messages in the same conversation. Alternatively the 
Conversation View can be switched on. 

 

Find a Correspondent quickly 

 

Click the Find Correspondent  button on the ribbon 
(Ctrl+F3). If looking for Fiona Mackay, enter mac  in 
the Folder List filter to short-list your Correspondents 
for easy selection.  

 

 
The changed 
background color 
tells you that you 
have a Folder List 
filter active. 

To clear  the filter, 
click Clear or press 
the Esc key. 

Jump to all messages for a Correspondent (or Bulk M ail folder) 

 

Click the Jump to Folder  (Ctrl+J) button on the 
ribbon to display all messages for the person from 
the currently selected email. 

Learn keyboard actions 

Using the mouse is generally great but it can be slower for actions you do over and over 
again. Using the mouse along with keyboard shortcuts provides the best performance. 

Consider all the time you spend moving your hand off the keyboard and onto to the 
mouse, then back again. Not everyone is a keyboard enthusiast, but even if you learn a 
few (or a few more) you'll save time.  
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Here's a technique for learning more: 
1. Print the Keyboard Shortcuts on the Help menu. 

2. Don't use your mouse for a few hours and instead use the keyboard shortcuts from the list.  

3. Learning them all is too much - focus on the operations you perform over and over. 

 E.g. Press F8 to jump to the Inbox from anywhere in NEO. 

 

Some basic tips 

Here are some basic tips for making NEO more productive for you. 

����  Work from Hot view and make folders hot 

Spend most of your time in Hot view and go to the other views when you need to. Make folders 
from other views hot so you can see them quickly. Some hot folder suggestions: 

o   Correspondents you are currently working with 

o   Date folders - This Week, Last Week, etc. 

o   frequently-used Categories 

o   frequently-used folders from your Outlook view Folder List 

����  Keep your Inbox or Active Mail small 

Whether you choose to work out of your Inbox or out of Active Mail, it really helps if you actively 
use the Quick File features or make messages Inactive to help reduce email clutter. Set your 
Backspace key appropriately. You can set the Backspace key from Tools | Options | Workflow 
tab. 

����  If you file to folders frequently, take advantage o f Quick File Recent's accelerator  keys 

First of all, set your backspace key to display the Quick File Recent menu (Tools | Options | 
Workflow tab). Notice that the first letter of each of your recently file-to folders is the accelerator 
key. When used in conjunction with Backspace, you can file without using a mouse. Here's what 
you type for these sample folders on your Quick File Recent menu: 

 

Reviews Press Backspace  then R to immediately 
file it. 

Meetings Press Backspace  then M to immediately 
file it. 

Budget Press Backspace  then B to immediately 
file it. 

����  Use Active Mail actively and reset it often 

The Active Mail folder shows new mail (when defined under Tools | Options | Workflow tab) that 
you have received since the last time you reset it. If you reset it whenever you look at a 
message, you’ll be able to quickly see when new mail has arrived.  
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Press  F11  to go to Active Mail from anywhere in NEO 
Press  F12  Make the current message inactive (reset Active Mail flag for this 
message) 

To reset Active Mail flag for groups of messages, use the following: 
Press  Shift+F11  to reset All Active Mail messages 
Press  Ctrl+Shift+F11 to reset Correspondent Active Mail messages 
Press  Ctrl+F11  to reset Bulk Active Mail messages only 

����  Develop your own email workflow methods 

There's plenty of flexibility in NEO to work with. Think about how you like to process mail and 
then put NEO's features to work for you. Review NEO's options and ensure they match the way 
you want to manage your email. Everyone will want to do it a little differently. Connect to our 
online Application Notes for workflow ideas – you will find them on our Knowledge Base.  

����  Use To Do 

By diverting messages to To Do that you have to take action on, you won’t have to keep seeing 
them as new messages arrive in the Inbox or Active Mail. 

Press  Alt+1, 2 or 3 to assign a To Do to your message (high, medium or low priority); 
you can now file the message as it will stay in your To Do folder. 

Press Alt+0  to clear the To Do status (it remains in the filed location!) 

Press  F10  to go to To Do from anywhere in NEO 

����  Don't get distracted by unimportant mail 

Reorganize less relevant email to Bulk Mail and use filters to filter them out until you want to read 
it. Edit the New Mail options so you are less distracted by unimportant new mail notifications. 

����  Don't forget daily housekeeping tasks 

See Things to Do Each Day. 

����  Learn keyboard commands for actions you perform oft en 

There’s a keyboard command (e.g. F8 to jump to the Inbox) for just about any action you take. 
You’ll save time if you learn even a few.  

����  Use Conversation View and Search to find messages 

Switch on Conversation View to find related messages instantly. Search is very fast in NEO. 
Consider using it to quickly find messages. Use the search entry box available in all views to 
quickly get to your messages. Or press Ctrl+Shift+F  to start a new search from the Search tab. 

����  Use the Folder List filter to find folders quickly 

At the top of each Folder List you can enter characters to narrow down the list of folders. Using 
this, especially in Correspondent and Category views, can be a huge time-saver. 

Press Ctrl+F3 to quickly find a correspondent in Correspondent view. 
Press Shift+Ctrl+F3 to quickly find a category in Category view. 
Press F3 to go to the Folder List filter of the current view.  

����  Create Bulk Mail folders 

Bulk mail consists of your mailing list messages and other less relevant messages. Reorganize 
these messages into Bulk Mail folders so your less relevant mail will be organized separately. 
Using Active Mail as an alternative for the Inbox, you can configure to only show (relevant) 
Correspondent Mail in your Active Mail folder (from Tools | Options | Workflow tab). 
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Options & Customizing 
  

Your Addresses 

About Your Addresses 

NEO needs to know which addresses are yours in order to automatically organize your 
messages. If all your addresses are not entered, your messages will not appear correctly. 

Note that NEO must know all your addresses  - not just your currently used ones. Be 
sure to include your old addresses if you have messages that used them. 

Auto-detecting your addresses on catalog creation 

NEO automatically detects your addresses when you create a catalog, and you can add to 
the list NEO auto-detects. Addresses you enter are displayed in bold. 

Important Note:      NEO does not auto-detect addresses you use after creating the catalog. 
You have to enter these manually. 
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Adding and removing addresses 

You can add addresses and you can remove addresses you add. Addresses NEO auto-
detects cannot be removed - however, you can choose not to include them by unchecking 
them). 

Click the Application Button menu | Your Addresses to keep your addresses up to date. 

            

 
To add an address, click the Add command. POP3 email addresses are entered in the 
usual way (e.g., bcoopersmith@fbi_NY.com). Exchange Server addresses are enter in 
X.500 format. 
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Options 

 
General Options 

These options control NEO startup and other general settings. 
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Workflow Options 

These options help you configure what happens when you take action on messages, 
whether Active Mail operates, and how you want Backspace to work. 
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Reading Pane Options 

These options relate to the Reading Pane. 

 

 
 

  



P a g e  | 28 

Formatting Options 

These options set how items are formatted. 
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New Mail Alert Options 

These options set automatic notifications that take place when new mail arrives (you can 
also learn how to change Outlook's new mail settings). 
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Miscellaneous options 

In this tab several additional options can be set as described below. 

  

Other Ways to Customize 

  

Resizing the Reading Pane 

The Reading Pane can be positioned either at the bottom or to the right of the screen. 
This can be defined on View menu. Size of the Reading Pane can be changed to any 
desired size by dragging the pane separator to a new location. Switching off the Reading 
Pane is done on the View tab. 

Note that you don't have to see the Message List pane in order to read them in the 
Reading Pane. You can use the following shortcut keys to move from message to 
message: 

Ctrl + Up                    Move to previous message  
Ctrl + Dn                    Move to next message 
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Resizing panes 

The panes in NEO can be resized. Place your cursor on the divider between the panes 
you want to resize and drag in desired direction. 

            

  

Changing Folder List sort order 

Each view can have its own sort order. Change the sort order by clicking one of the three 
buttons at the top right. 

 

 

Changing Reading Pane fonts 

There are three message formats for the Reading Pane: HTML, Microsoft Outlook Rich 
Text, and Plain Text. Here's how the change the text characteristics. 

HTML messages 

Change the relative size of HTML text in two ways: 

•         Click View menu | HTML Text Size. 

•         Set on via Reading Pane options (Tools menu | Options | Reading Pane tab) 

Plain text messages 

Change the characteristics of Plain Text messages: 
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•         Set on via Reading Pane options (Tools menu | Options | Reading Pane tab) 

Microsoft Outlook Rich Text 

This message format cannot be modified in the Reading Pane. 

Moving the View tabs 

The NEO View tabs are positioned by default at the top of NEO because the tabs are 
easier to access there. You can position them at the top or the bottom of NEO.  

Right-click  on any part of the View tab and make your selection:  

           

Undocking and docking views 

When you start NEO for the first time you will see the default NEO workspace. In it, Hot 
view is in the top left panel, Outlook and Correspondent views are below it, the List Pane 
is in the middle and the Reading Pane is to the right of it. 

The top left view is the home view position . When you click a view on the Viewtab, it 
replaces its contents. The home view position, the List Pane and Reading Pane cannot be 
moved but they can be resized. 

Optimize view positions to suit your workflow 

All view positions are configurable in NEO. You can undock any view and have it float 
above your workspace, you can dock the views onto the workspace surface in any 
position, you can change the order of the views on the View tab, and you can even hide a 
view. 

From the View | Layout tab, you can load a predefined view with NEO views left and right 
of the Message Listing / Reading Pane. To illustrate, here's an example layout with views 
left and right.  

  

Save your Layout settings by exporting them 

When you have finalized setting your layout, it is best to save your layout settings by 
exporting them: View | Layout | Export Layout.... When it is necessary to reset your User 
Interface it is easy to restore your layout by importing the saved settings. 
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How to reset the User Interface 

When you like to restart with the original layout, or when the User Interface needs to be 
reset: 

Reset your layout On the View menu, click Layout | Reset Layout. This will restore your 
layout to the default layout. 

Reset User Interface Close NEO, click Ctr+Shift while double-clicking NEO icon to start the 
program. Confirm dialog to reset the User interface settings. 

Configuring your views 

The key point to remember when moving views is that a view can only be moved to a new 
location when it is undocked (floating). 

Undock a view that is currently docked on the Viewtab 

Double-click the view on the Viewtab. 

Undock a view that is currently docked on the workspace surface 

Double-click the titlebar of the view panel.  

Dock an undocked view back onto the Viewtab 

Drag the floating toolbar's titlebar on top of the Viewtab. As you move it over the tabs, 
drop it when the insert indicator appears.  

Dock a view onto the workspace surface 

If it is not already undocked, double-click the tab (if on the Viewtab) or double-click the 
titlebar (if already docked on the workspace surface).  

Now that it is undocked, drag it by the titlebar to a dockable location. As you get close 
to a location it will snap into place with a line marker indicating its location. Drop it 
where you like.  

To move it so that it appears as a vertical column, place your cursor exactly on the 
juncture between two stacked panes (for example, the dividing line between the List 
Pane and the Reading Pane).  

Hide and restore a view 

To hide a view, press Alt+F4 when the view has the focus and is undocked.  

To restore a hidden view, go to View menu | click Views then click the view you want 
to make visible again.  

  

Adding and changing columns 

Column sort order 

Sort your messages by changing the column sort order.  

  

  

The indicator on the Date/Time column signifies the current sort column.  Click it again the 
change the sort direction, or click another column to change the sort column. 

Each folder can have a different sort order. 
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Changing column width 

Place your cursor at the start of a column until the resize icon appears (see below), then 
drag it right or left. 

  

When you change the column width for a view, it changes for all views except Attachment 
view which can be set independently. 

Changing column order 

Left-click drag the header of a column and drag it to the new location. 

Selecting which columns to display 

Right-click on any column. This list of available columns will appear for you to check or 
uncheck. 

 

List pane Name column  

The Name column in the List Pane shows the From name  for incoming messages and 
the To name  for outgoing messages. This is fine for simple correspondence between you 
and another person. 

For mailing list messages, however, the actual originator of the message is different than 
the Folder name. In fact, there are often many different originators and it's important to 
know who the message is from in addition to the list the message is to. 

Here are the different ways to set this property: 
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Notice above that the folder name is very short to make more room for the original name. 
Also, specifying the folder name in upper case makes it stand out from the original name. 

You can set what's included in the Name column by right-clicking any Correspondent or 
Bulk Mail folder and choosing Properties.  

Customizing the ribbon 

By default, NEO comes with a Ribbon with a Quick Access Toolbar on top of it. You can 
customize these in several ways: 

•         Add commands to the Quick Access Toolbar 

•         Customize the Ribbon  
            - add commands 
            - modify commands 
            - remove commands 

When switching to Toolbars, standard Windows toolbar customization can be made. 

It's very useful to modify your Quick Access Toolbar to add commands and filters you use 
frequently, or remove ones you use infrequently. 

 
Hide or show the Ribbon 

To save space, the Ribbon can be minimized by clicking Ctrl+F1. Clicking this shortcut 
again will show the Ribbon again (or right-click and (de)select Minimize Ribbon). 

When minimizing the Ribbon, make sure all your frequently used commands sit on the 
Quick Access Toolbar. 

Customize Quick Access Toolbar 

Right-click any command and select Add to Quick Access Toolbar. 

To change order of the Quick Access Toolbar, right-click anywhere on the Ribbon and 
select Customize. Once in Customize mode, commands on the Quick Access Toolbar can 
be dragged into any position. 
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Customize the Ribbon 

Customize the Ribbon by right-clicking anywhere on the Ribbon and choose Customize. 

You can reset any Ribbon parts back to its original state. 

           

 
Add a command 

           

Select Commands tab, select a Category and then locate the desired Command. Drag 
and drop the command onto the Ribbon in the location you want.  
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Modify a command 

With the Customize dialog visible, right-click a command on the Ribbon. A grey box 
should appear around it to show you are in edit mode and the command edit menu 
will appear.  

           

Delete a command 

Modify a command as per above, and choose Delete or drag it away from the Ribbon. 

Customize menu and toolbar options 

You can change the behavior of the menu and toolbars by going to the Options tab of the 
Customize dialog. 

           

Master and user-defined categories 

In NEO Pro, the categories you assign may be ones you define, or they may be ones you 
pick from the Master Category List.  

Regardless of whether they are defined by you or picked from the Master Category List, 
once assigned to messages there is no difference between a master or user-defined 
category. 
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Master categories 

There's really nothing complicated about master categories or the Master Categories List. 
The "list" is simply a list of categories stored in your registry. Outlook delivers a list to get 
you going, but you can and should improve on it if you plan to use Master Categories at 
all. 

At best the Master Categories List serves as a pick list from which to choose regularly 
occurring categories.  

User-defined categories 

There is no limit to the number of categories you can add, which makes them ideal for 
organizing your projects and activities. You can add your own categories to the Master 
Category List if you like. Selecting the appropriate option on the Category Picker (Ctrl+T), 
you can add all your user-defined categories to the Master Category list. 

  

Email Improperly Configured on your computer 

You may receive an error issued from Microsoft Outlook when you start Outlook or NEO. 
Here's how to address the problem. 

Ensure you are running the correct Microsoft versio ns 

NEO works with all Microsoft Outlook versions but does not work with Outlook Express. 

NEO also works with Exchange Server. For Exchange Server Version 5.5 Exchange 
Service Pack 3 or above must be installed. For Exchange 2000 Server, Exchange Service 
Pack 2 or above must be installed. Your Exchange administrator can provide this 
information. 

Other ways email may not be properly configured 

NEO requires that both Microsoft Outlook and MAPI are properly configured on your 
computer. MAPI is an email subsystem that is normally installed when you install 
Microsoft Outlook. 

However, components of Outlook and/or MAPI can get corrupted. This can occur when 
you change versions of Microsoft Outlook or add new features, when you change modes 
such as from Internet Only Mode to Corporate or Workgroup mode, or when you use 
some other email programs that replace the correct version with their own versions of 
MAPI. 

Here are the steps to take to ensure your email subsystem is properly configured. All 
steps may not be required. You may want to print this topic by clicking the Print command 
on the Help toolbar.  

1.   Close NEO, Outlook and any other programs you have running. To be absolutely sure no 
email component programs are running it is best to restart your computer (assuming such 
programs don’t start automatically on startup). The following steps will not work if any part of 
MAPI is running. 

2.   Ensure “Microsoft Outlook” is your default email program. To change the setting: click Start, 
point to Settings, click Control Panel, then double-clicking the Internet Options icon. Click the 
Programs tab, then choose Microsoft Outlook as the E-mail program. Do not choose Outlook 
Express.  

3.   Run the Microsoft FixMAPI program. This program does not exist on all computers. To find 
whether it exists on your computer, click Start, point to Find then click Files or Folders. Enter  
fixmapi.exe  in the Named field and click Find Now. If it is found, perform the following 
substeps:  
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o    Click Start, point to Find then click Files or Folders. Enter  mapi32.dll  in the Named 
field and click Find Now. Right-click each copy found, click Rename and 
enter mapi32.old. If you are not able to rename all files then MAPI is running and you 
should perform step 1 above. Close the Find program.  

o    Click Start, click Run, enter  fixmapi.exe in the Open field and click OK. This will run 
quickly and provide no confirmation information that it has completed.  

o    Restart your computer and try NEO.  

4.   Re-install Microsoft Outlook. Perform this step ONLY if step 3 above was unsuccessful.  

o    Click Start, point to Settings then click Control Panel. Double-click the Add/Remove 
Programs icon and then double-click Microsoft Outlook from the list. Have your install 
CD handy.  

o    After re-installation, restart your computer and try NEO.  

If none of the above steps correct the problem, please send an email to 
support@caelo.com describing your symptoms and what steps you have taken. 
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Using with Outlook 

Switching Between NEO and Outlook 

You can switch between NEO and Outlook in two ways: 

From NEO 
1. Click the Outlook button on the View tab of the Ribbon, or   

2. Press Ctrl+0. 

From Outlook 

1. Click the NEO button    on the toolbar, or   

2. Click Tools menu | Switch to NEO. 

If the program you are switching to is not open, it will be opened. 

Interacting with Outlook items 

Here are actions you can take on Outlook items from within NEO: 

Switch quickly to Outlook 

Switch to an area in Outlook such as contacts, calendar in two ways: 

a)   Click the Outlook  command on View tab of the Ribbon, or (or press Ctrl+0 (zero)) 

b)   Click the pull down menu from this Outlook command and choose to go to a particular 
area of Outlook, or press these shortcuts to go to: 

               Ctrl+0 Outlook  
         Ctrl+1 Inbox     
         Ctrl+2 Calendar 
         Ctrl+3 Contacts 
         Ctrl+4 Tasks 
         Ctrl+5 Notes 
         Ctrl+8 Journal 

c)   Double-click an Outlook non-mail folder     in Outlook view. 

Open a new item in Outlook  

For example, a new appointment.  

Click the New Item  dropdown on the Home tab of the Ribbon. Or use a keyboard shortcut:  
(these match those in Outlook):  

      Ctrl+Shift+A New Outlook Appointment 
Ctrl+Shift+C New Outlook Contact 
Ctrl+Shift+J New Outlook Journal Entry 
Ctrl+Shift+K New Outlook Task 
Ctrl+Shift+N New Outlook Note 

Open the Outlook contact record  

Jump  to an existing contact record, or create a new one.  
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Select any message or any NEO Correspondent or Bulk Mail folder, then right-click and choose 
Open Contact  (or press Shift+Ctrl+O).  

NEO also automatically imports contact information when new Correspondent folders are 
created. 

Work with Outlook mail folders   

  In Outlook view, work with these just as you would your folders in Outlook. 

Drag and drop to Outlook non-mail folders     
You can drag and drop  messages to these folders, but you can’t display their contents within 
NEO (double-click to open in Outlook).  

Interacting with Contacts and Address Books 

NEO interacts with Contacts in two ways. 

When creating new Correspondent folders 

When automatically creating a new Correspondent folder, NEO imports relevant contact 
information such as name, company, telephone numbers and email addresses. 

NEO first checks to see if a Contact exists for the address based on an email address 
match. If a Contact matches, correspondent information is taken from the Contact. If no 
contact is matched, then NEO does a lookup in all Address Books for a matching entry. If 
a match is found, correspondent info is taken from the Address Book. NEO adds all 
addresses from the Contact/AddressBook to the Correspondent folder, except for 
addresses that already exist in NEO.  

Note that this is a one-time import from Contacts and is not synchronized in an ongoing 
way. If you make changes to the Correspondent fields they are not then reflected in your 
Contact. 

When jumping to a Contact or Address Book entry 

Right-click any message, Correspondent folder or Bulk Mail folder, and choose Open 
Contact (or press Shift+Ctrl+O). If the Contact exists you will jump to it.  

If the Contact doesn't exist you will be asked whether you wish to create one.  If added 
from a message, relevant message information will be carried forward. If added from a 
folder, relevant information from the folder (Correspondent or Bulk Mail) will be carried 
forward. 

On the Folder Properties for Correspondent or Bulk Mail, you can also choose between 
opening the Contact or looking up in the Address Book. 

How NEO Works with Exchange Server 

NEO works with Microsoft Exchange Server mailboxes. However, NEO is an email 
organizer. It does not organize other Outlook object types such as calendar items, journal 
items, and note items although it does provide ways to interact with them. 

Here are some notes about using NEO with Exchange Server: 
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NEO is a client-side product 

That means NEO installs and operates completely on your computer. There is nothing 
about NEO that gets installed on the server or that is related to Exchange Server. In fact, 
Exchange Server is completely unaware of NEO.  

You can organize your Mailbox and your PSTs 

You can include your mailbox and as many PSTs as you like in your catalog. NEO Pro will 
give you a seamless view to all your messages. NEO makes it appear as though it's all in 
your Mailbox.  

Using your offline message store (OST) 

When using Offline mode or Cached Exchange Mode it is best to delete messages from 
within NEO. If messages are deleted outside of NEO (in Outlook or via an Outlook Rule), 
they may not disappear from NEO until a Full Sync is performed.  

Offline mode using Outlooks prior to Outlook 2003 

If you have offline access enabled (you use an offline message store), you should 
select all your email folders for OST/Mailbox synchronization. In addition, you should 
not set filters for your folders.  

You will not lose messages when you do this; however, if you do not include all your 
folders NEO may spend quite a bit of time removing and adding messages in the 
catalog each time you switch between your OST and your mailbox.  

If you have instructed Outlook to automatically Outlook synchronize your Exchange 
mailbox with your OST when exiting an online session, you must shut down Outlook 
without NEO running for the synchronize to be performed.  

Cached Exchange Mode in Outlook 2003/2007 

NEO works with normally with Cached Exchange Mode.  

Reminder – Synchronize each time you re-connect to t he LAN 

Whenever you re-connect to the LAN, you must synchronize to update NEO with new 
messages from your mailbox. Note that you can configure NEO to automatically Fast 
Sync on startup, or get general information about syncing. 

 
Synchronizing with Outlook 

NEO normally displays all the messages in your message store(s). However, NEO doesn't 
know about new, changed or deleted messages that are processed when NEO is not 
running. 

How it works ... in a nutshell 

If NEO is running when new messages arrive, are changed or deleted, then you'll always 
see all your messages in NEO (NEO keeps you synchronized on-the-fly). 

If NEO is not running, then NEO will not know about these message events and will need 
to get synchronized again by you syncing manually (e.g., when you next start NEO). 
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Always run NEO! 

It’s best to always have NEO running when Outlook is running so your email stays 
synchronized. 

It's also better to start Outlook before starting NEO and always keep it running when 
Outlook is running. 

Exchange Server users 

You should always have NEO running when you are connected to the LAN. You may want 
to put NEO in your Windows Startup folder so it starts automatically.  

Non-Exchange Server users 

You should always have NEO running when you have Outlook open. You can configure 
NEO to start automatically when you start Outlook. See Startup tab in General Options. 

Options Set in Outlook and Used in NEO  

Some user options are shared by both NEO and Outlook. 
1. Print setup . 

2. Message editor fonts . To set these in Outlook, see Tools | Options | Mail Format tab. 

    You can set NEO Reading Pane options within NEO via Tools | Options | Reading Pane. 

E-mail accounts settings are added in Outlook. 
  

How to disable the Outlook New Mail sound and Tray 
Icon 

If using NEO's New Mail Notification, you might want to disable the sound Outlook plays 
when new mail arrives, and/or cancel Outlook's new mail icon in the system tray.  

Note :    You can cancel the sound in any version of Outlook; however, you can only disable the 
tray icon in Outlook 2002 or higher. 

Steps: 
1. Go to Options in Microsoft Outlook (Tools menu | Options). 

2. Click <Email Options...> on the Preferences tab. 

3. Click <Advanced Email Options...>. 

4. Uncheck "Play a sound" 

5. Uncheck "Show an envelope in the system tray" (Outlook 2002 or higher only). 

6. For Outlook 2003 (and above), you can also configure the Desktop Alert Settings in this area. 

Things we can't easily fix 

Outlook and its infrastructure provide a rich environment for implementing add-on 
applications such as NEO. However, some actions are simply not possible, or are 
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possible only with a large amount of "work-around" programming. We forward many 
operations along to Outlook to perform for us, and in many cases it’s not possible to 
control how these operations are performed. 

We appreciate that this makes some operations awkward, and we’d love to fix them (we 
often do), but can’t in every case. Here are some of the things we can’t easily fix. 

• Previous & Next buttons don’t work on the message e dit window 
As an add-in to Outlook, Microsoft does not make these commands available to us. 

• Outlook’s New Mail tray icon not cleared when mail read in NEO  
In some cases, you can disable it using options. 

• Print options can’t be set in NEO 
NEO uses the settings currently set up in Outlook. You can choose print options for selected 
message(s) if you open the message then choose Print on the File menu. 

• Subfolders of non-email items (e.g., Tasks) not vis ible in NEO 
The Outlook interface does not provide the ability via automation to drag and drop to 
subfolders. 
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NEO Views 

Overview - Views 

What are views? 

Views show you your messages in all the different ways you think about them – new 
messages, by correspondent, by date, and so on. 

In views, messages appear in more than one location at the same time. For example, a 
message you receive today will be in the Today folder in the Hot view, it will be in the This 
Week folder in Date view, it may be in a Correspondent folder, and even a search results 
folder in the Search view if you find it in a search. If you delete a message from one view, 
it will be deleted from all your views. 

In short, even though you see the same message in different views, it’s really just one 
message presented to you in different ways. 

Using views 

Views don’t require any work – they’re set up automatically for you to use. You simply 
click each view tab to move from one view to the next. 

A quicker way to move from view to view is to use your keyboard: Alt+C to switch to 
Correspondent view, Alt+S to switch to Search view, and so on. 

Outlook View 

 

Outlook View  

Outlook view is your 
view into your Outlook 
Folder List. 

The example at left 
shows multiple data 
files. 
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Correspondent View 

 

Correspondent View  

Lists all people you 
correspond with 
directly. These include 
people you send 
messages to and 
people who send 
messages directly to 
your email 
address(es).  
  

Bulk Mail View 
  
  

 

Bulk Mail View  

Bulk Mail is the place 
for your "news" mail - 
e-zines, newsletters, 
subscriptions … 

It is also where 
Unsorted 
(unorganized) mail 
and Spam Senders 
appear. 
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Search View 

 

Search View  

NEO's search is like a 
web search. It's fast like 
a web search because 
all the words in all your 
messages are 
automatically indexed. 

You can save search 
folders (as shown at the 
bottom).  
  

Hot View 

 

Hot View  

To keep tabs on 
particular folders put 
them in your Hot view. 

All folders in the Hot 
view are optional, 
although by default a 
few folders are set hot 
so you can see your 
new and recent mail 
easily. You can 
customize Hot view to 
contain exactly the 
folders you need. 

To make any folder 
hot , right-click the 
folder and choose 
Make Hot . 

Hot view is the best 
place to work with the 
Inbox and To Do. 
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Category View 

 

Category View  

Categories are words 
or phrases that you 
can define and use to 
keep track of related 
messages.  

When you add the 
same category to 
more than one 
message they are 
displayed together in 
an auto-created 
category folder in 
Category view. 
  

Status View 

 

Status View  

Lists your messages 
according to the 
status of each 
message. 

The status of each 
message is shown in 
the List Pane. Use 
these folders to see 
all same-status 
messages together. 

It's useful to make 
some of these folders 
hot. 
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Date View 

 

Date View  

Lists your messages 
in folders categorized 
by date. Date folders 
are automatically 
created for you. 

Relative  date folders 
are folders such as 
Today, Yesterday, 
etc. They 
automatically update 
as time goes by. 

Monthly  date folders 
exist for every month 
you have email. Only 
this type of date folder 
can be deleted.  

  

Attachment View 

 

Attachment View  

Lists every email 
message that 
contains an 
attachment. An email 
will appear once for 
each attachment it 
contains. 

Since attachments 
can take up valuable 
space, you should 
consider deleting 
them if you are done 
with them. A quick 
way to find your 
largest attachments is 
to select the All 
Attachments folder, 
then sort in 
descending order on 
the Size column. 
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Message Basics 

Creating and responding to messages 

You create new messages, reply to messages, and forward messages in the same way 
you do with your messages in Outlook. In fact, the message editor you use is the same as 
the one used by Outlook. For assistance in using the message editor, refer to Microsoft 
Outlook’s help. 

Viewing a message  (Enter or Ctrl+O) 

Double-click a message in list view, or select a message and press Enter of Ctrl+O.  Once open, 
you can click the Reply, Reply to All, or the Forward command. 

Creating a new message to an existing correspondent    (Ctrl+E) 

Select any message or Correspondent/Bulk Mail folder and right-click or press Ctrl+E. A new 
message will open for your selection. 

Creating a new message   (Ctrl+N) 

Click the New command on the Home tab, or enter Ctrl+N. After entering the address 
information, the subject and the message contents, click Send. 

Replying to a message   (Ctrl+R) 

Click the Reply  command on the Home tab, or enter Ctrl+R. After entering the message 
contents, click Send. 

Replying to all respondents in a message   (Ctrl+Sh ift+R) 

Click the Reply All  command on the Home tab, or enter Ctrl+Shift+N. After entering the 
message contents, click Send. 

Forwarding a message   (Ctrl+F) 

Click the Forward  command on the Home tab, or enter Ctrl+F. After entering the address 
information and the message contents, click Send. 

Editing the message subject 

In NEO you can edit the subject of any message directly in the Reading Pane header. 

    

With the Reading Pane visible,  
1. Click into the subject field, or  

2. Right-click selected message and choose Edit Subject, or 
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3. Press Ctrl+B. 

Adding and editing message categories 

In NEO Pro you can add or edit message categories directly in the Reading Pane header. 

   

Adding and editing message notes 

 

NEO Pro lets you add Notes to a message to keep some personal information with the 
message. 

With the Reading Pane visible, click the Notes icon  (or click Ctrl+Alt+N) to open the 
Notes editor. You can now add your notes with this message. The Note will be saved 
automatically once you exit the Notes editor and a Notes icon will be placed in the 
Message Listing. Also this message will now be visible in the Noted folder (in the Status 
tab and mostly also in the Hot View). Notes are unique to NEO Pro and stored locally on 
your system. They will never be attached to a message reply or forward. 

Right-clicking in the Notes editor allows for formatting and other options. Default Font for 
Notes can be defined by going to Tools | Options | Reading Pnne tab. 

  

Editing and resending a message 

Editing a message 

Any part of a message can be edited whether or not it was sent or received by you. 
1. Open the message. 

2. Click Edit menu | Edit Message. 

Resending a message 

Useful for emails that you send over and over.  A copy of the message will be created for 
you to edit before sending. 

1. Open the message. 

2. Click Actions menu | Resend This Message. 

3. Make your changes to the message. 

4. Click Send. 
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Moving Back and Forward 

Use the back and forward commands to quickly jump back or forward to previously-visited 
folders. This is very useful, for example, after performing a search. 

The Back and Forward buttons are located on the right side of the header above the list 
columns: 

     

Or press Alt+Left  for Back or Alt+Right  for Forward. 

Quick Filing Messages 

In addition to all the basic filing  methods such as dragging messages, using File to 
Folder (Ctrl+Shift+V), and Outlook Rules, NEO has two Quick File features : 

Quick File 

 

Click Quick File  on the Home tab of the Ribbon (or press 
Ctrl+I). This will immediately file the message to your 
designated Quick File folder. 

Quick File Recent 

 

Click Quick File Recent  on the Home tab of the Ribbon 
(or press Ctrl+Alt+V). This displays a list of your most 
recently filed-to folders for easy selection. 

  

 

  

Use the accelerator keys  for 
quick selection. For example, 
pressing M will file immediately 
to the Meetings folder. 

You can change the Quick File 
Recent menu using the Clear 
List and Disable List Updates 
commands. 

  

You can get more productivity by setting your Backspace key to either Quick File or to 
display your Quick File Recent menu (default). You can set the Backspace key by going to 
Tools | Options | Workflow tab. 
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About Active Mail 

Active Mail is an optional feature that provides an extra layer of control in managing mail. 
Active Mail is like a staging area for your mail until you have time to read it, make a 
decision and then act on it (delete, file, etc.).  

How Active Mail works 

In NEO Pro, each message can be Active or Inactive much the same way a message can 
be Read or Unread. If a message is Active it is in the Active Mail folder, and if not it isn't. 
As with Read/Unread, you can make any message Inactive or make it Active again.  

The Active Mail folder is found in Status view but can (and should) be made Hot if you use 
Active Mail. When a message is Active you will see the Active status  in the list pane.  

When you use Active Mail, you normally use Active Mail  instead of your Inbox . 
However, unlike your Inbox where all your mail arrives, you tell NEO what new mail to put 
into Active Mail from Tools | Options | Workflow tab. If both boxes (Correspondent Mail 
and Bulk Mail) are unchecked then no new mail will go into Active Mail.  

Using Active Mail to implement time-management comp liant email workflow 

Starting version 3.2, NEO Pro comes with a few predefined User Interface settings. One 
set of UI settings is specifically designed to facilitate the implementation of an email 
workflow which is compliant with general time-management principles to deal in the most 
efficient way with the daily email activities. Implementing this way of working will result in 
an important reduction of actions need to manage the daily emails and create significant 
time-savings per day by relying on the available features and functionalities of both 
Outlook and NEO and combining them to optimally function together. 

For a clear explanation and guideline on how to implement this way of working please 
refer to our Knowledge Base article T1165. 

Is Active Mail better than Quick Filing to folders?  

The key feature  of Active Mail is that you can quickly say "I'm done with this message" 
without having to move the message from the Inbox (or wherever it is stored) to another 
folder. When you make a message Inactive, it disappears from your Active Mail folder but 
can still be found in NEO's virtual folders (e.g., Correspondent) and of course the Outlook 
folder it lives in. Active Mail helps many users manage their email in a way that's similar to 
how they manage their postal mail.  

You can do more operations with Active Mail in NEO (see How Active Mail is Different 
below). However, if you don't also file to folders, all your messages stay in one folder , 
typically the Inbox. That's not a problem for many users, but can be a problem is you need 
to ever read your mail outside of NEO (e.g., Outlook Web Access), or you want to work 
with your email on external systems like mobile devices where Active Mail is not available.  

Some prefer Quick File without Active Mail for Outl ook-like behavior 

If you prefer a NEO that looks and operates more like Outlook, you can choose not to use 
Active Mail (see Options | Workflow tab) - some users really like this simpler approach. 

How Active Mail is different 

It’s like the traditional Inbox because … 

•         new mail arrives here 
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•         sent mail is not included (unless you make sent mail Active) 

It’s not like the traditional Inbox and other NEO folders because … 

•         you can remove messages without deleting or filing them 

     a) single message  (Backspace or F12) 

     b) all at once  (Shift+F11) 

     c) just Correspondent mail   (Shift+Ctrl+F11) 

     d) just Bulk Mail  (Ctrl+F11) 

•         you can specify to have them removed automatically on performing actions like setting 
inactive or when filed to an Outlook folder. You can set these options in the Automated 
Actions section of Workflow options. 

•         you can put messages back into Active Mail – including sent messages! 

•         the Folder Count format for Active Mail is different. You can change the Folder Counts 
format on any folder by right-clicking and choosing Properties. 

Using To Do 

To Do is a folder you can send mail to that you want to take action on later. 

  

How to Set or Change To Do Status 

You can: 
a) left-click drag  to the To Do folder from anywhere in NEO to set Normal priority, or 

b) right-click drag  to choose priority, or remove from To Do, or 

c) use shortcut keys: 

Alt+0       Remove priority  (or Alt+`) 
Alt+1       High priority 
Alt+2       Normal priority 
Alt+3       Low priority. 

To Do Status in List Pane 

To Do status is visible in every folder. In the To Do folder you may want to sort by To Do 
status. Here is what the states look like: 

 

If you are in Active Mail when you set To Do status, you can specify to have messages 
removed from Active Mail automatically. You can set that option on the Workflow tab of 
Options.  
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Find Related Messages 

Use Conversation View  

To see all related messages in your message listing, switch on the Conversation View 
(from View tab or clicking the Conversation View button on the Quick Access Toolbar). 
Use the Left Arrow to expand a conversation, use the Right Arrow to collapse a 
conversation. You can right-click any message and select Expand Conversation to 
expand all conversations. Likewise you can select Collapse Conversation to collapse all 
conversations. For an expanded conversation, the parent (belonging to the selected 
folder) will always show on top – therefore a sent item which was sent later can show 
below the parent. 

Using Conversation Integrity (Tools | Options | Miscellaneous tab), actions carried out on 
the ‘parent’ will propagate to the underlying ‘childs’. E.g. adding a category to the parent 
will add this category to all messages belonging to this conversation. Actions included are: 
status changes (Read, Keep, Active), adding/removing categories, filing and delete. 

Search on Conversation 

To quickly see all related messages for a single message: 

•         Click    on the Standard toolbar, or 

•         Press Ctrl+Alt+F. 

You will then be quickly positioned in Search view with all messages based on the same 
'conversation' displayed. 

   

When done, click     or press Alt+LeftArrow  to go back to the folder your came from. 

About 'Conversation' 

Every message has a property called Conversation, and it is usually the same as the 
Subject property but it can be different. 

When a new message is created, the current Subject is copied to the message's 
Conversation. However, if the Subject is edited (Ctrl+B), the two will be different. 
Conversation always remains as the original Subject. 

Flagging Messages 

Flag a message when you want to mark it for some purpose. Flags in NEO are 
coordinated with flags in Outlook, and the same colored flags exist in both systems (if 
supported in your version of Outlook).  
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Set a flag by right-clicking the message(s) and choosing Flag:  

          

 
Choose colored flags for different purposes. You can flag an item Complete, and you can 
Clear the flag (Ctrl+Shift+G). 

One flag is always the default flag. It's the flag color that gets set when you use Ctrl+G to 
set the flag. You can also change the default flag to any of the colored choices. 

Keeping Messages 

Keep  a message when you don’t want to accidentally delete a message. It’s very useful 
for those important messages. 

If you try to delete a kept message, it will not be deleted. To delete a kept message you 
must remove the keep status first. 

            

This symbol indicates the message is being kept. Messages not being kept have no 
indicator. 

Set a keep              Select the message(s) and enter Ctrl+K.  

Remove a keep        Select the message(s) then right-click and choose Remove Keep. 

You can set a keep in any location in NEO. It will be displayed in all views in which the 
kept message appears. 

Deleting Messages 

Deleted messages go to Deleted Items 

To delete a message or messages, highlight the messages and press Ctrl+D, press the 
Delete key, or click the Delete command button on the toolbar. 

When messages are deleted in NEO they are moved without warning to your Deleted 
Items folder in Outlook view. You can get them back if you need to by moving them from 
Deleted Items to another folder. 

You can permanently delete a message by pressing Shift+Del 

Note :    In NEO, the same underlying message is displayed in many different folders. When you 
delete a message, all references to the message are deleted too. 
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‘Deleted Items (All)’ folder 

Outlook keeps a Deleted Items folder for every Message Store (PST). NEO combines all 
these in its ‘Deleted Items (All)’ folder which you can find on the Status Tab. Emptying this 
‘Deleted Items (All)’ folder will empty all Deleted Items folder independently of their 
message store. An easy way to remove all deleted items within your entire Outlook 
system. 

Deleting saved search folders and messages 

If you delete a saved search folder, just the saved search results are deleted – the 
underlying messages remain. However, if you delete a message or messages in a saved 
search folder, the underlying message is also deleted. 

When messages are permanently deleted, they cannot be retrieved. 

Permanently deleting messages 

Messages are permanently deleted when they are removed from the Deleted Items folder. 
Permanently deleted messages cannot be retrieved. 

NEO provides a ‘Deleted Items (All)’ folder on the Status tab holding references to all 
messages in all Deleted Items folders within Outlook to quickly remove all Deleted Items. 

Permanently delete messages directly 

Enter Shift+Del to permanently delete a message without first sending the message to 
Deleted Items. 

Delete messages from the Deleted Items folder 

Select the message(s) in the Deleted Items folder in Outlook view, and press the Del key. 

Empty the Deleted Items folder 

Right-click on the Deleted Items folder (or the ‘Deleted Items (All)’ folder on the Status 
tab) and click Empty Folder. The Deleted Items folder is never emptied automatically, 
regardless of your Outlook settings. 

Undoing Actions 

You can UnDo (reverse) many operations in NEO, and you can ReDo (reinstate) those 
that you Undo.  

Keep in mind that only the last action can be undone or redone. That is, to be able to 
UnDo something you must do it before you perform another action. 

UnDo-ing and ReDo-ing 

o    Click UnDo or Redo on the main Edit menu.  

o    Or press Ctrl+Z which toggles between UnDo and ReDo where applicable 
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Eligible Actions 

o    Modify Subject in Reading Pane 

o    Add/delete/change Categories 

o    Move messages (except with OST's prior to OL 2003 and moves between message 
stores) 

o    Delete messages (except with OST's prior to OL 2003) 

o    Make Active / Inactive 

o    Keep / Remove Keep 

o    Flag / Clear Flag / Flag Completed 

o    ToDo / Remove ToDo 

o    Mark Read / Unread 

Copy Reply-To Email Address to Clipboard 

Right-click any message in the List Pane or Reading Pane and choose Copy Reply 
Address to Clipboard  (or press Ctrl+Alt+C). 

This silently replaces whatever is on your clipboard with the message sender's Reply-to 
email address.  

This feature is handy for quickly grabbing the address for use in other systems. You can 
also use it to send a new message to a person and avoid the Outlook Security Guard 
prompt. For keyboard shortcut fans, try Ctrl+Alt+C    Ctrl+N    Ctrl+V . 

Sending and Receiving 

Messages are sent and received in NEO in the same way they are sent and received in 
Outlook. This is completely determined by your Outlook settings. 

If you are not connected to your Internet service provider, or to your mail server (e.g., 
Microsoft Exchange Server) when you click Send in the message editor, the message is 
sent to your Outbox. 

            

When you then click the Send/Receive command on the toolbar (or press Ctrl+M or F9) 
your messages will be sent from your Outbox, and incoming messages will be received 
according to your Outlook settings.  

For assistance in configuring Send/Receive, refer to Microsoft Outlook’s help. 

  

Viewing Message Properties 

Right-click any message in list view then click Message Properties or press Alt+Enter.  
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Location  lists all the NEO folders that contain the selected message. This is especially 
useful for determining what Correspondent or Bulk Mail folder a selected message is 
stored in. 

The message in the example below was received last week. Thus it is in the Last Week 
and the December date folders.  It’s still in Active Mail, and a category has been set for it. 

  

The actual message is stored in the Outlook Inbox. Note that you can also see what 
Outlook folder a message is stored on the Folder  field on the Reading Pane header. 

Message Symbols 

See Reference section at end of Help. 
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Working in the 
Reading Pane 

Reading Pane overview 

The Reading Pane displays beneath or to the right of the List Pane. Here is the Reading 
Pane header. 
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Reading Pane Options 

These options relate to the Reading Pane. 

 

Clicking Links to Launch Your Browser 

If your browser is open when you left-click a web link, the page replaces the current page 
loaded in your browser.  To launch a web-link in a separate browser window, left-click the 
web link while holding down the Shift key. 

Click link           Launch web-link in your current browser window  (replacing currently loaded 
page).   

Shift+Click link       Launch web-link in a new browser window . 

See keyboard shortcuts on the Help menu for a list of all keyboard shortcuts. 
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Editing in the Reading Pane 

You can't edit text in the Reading Pane body. However, you can edit the Subject and 
Categories in the Reading Pane header. 

Click into the fields in the Reading Pane header, or press: 
Ctrl+B  To edit the message subject. 

Ctrl+T  To edit categories using the category picker. 

Shift+Ctrl+T  To edit categories is the header category field. 
  

Resizing the Reading Pane 

The Reading Pane can be positioned either at the bottom or to the right of the screen. 
This can be defined on the View menu. Size of the Reading Pane can be changed to any 
desired size by dragging the pane separator to a new location or by using the keyboard 
shortcuts. Switching off the Reading Pane can be done through the View menu. 

Keyboard shortcuts 
 

Ctrl + Alt + Up Reading Pane On 

Ctrl + Alt + Down Minimize Reading Pane 
Shift + Ctrl + Up Increase Reading Pane 

Shift + Ctrl + Down Decrease Reading Pane 
Shift + Ctrl + PageUp Maximize Reading Pane 

Shift + Ctrl + PageDown Restore Reading Pane 
 

Note that you don't have to see the List Pane messages in order to read them in the 
Reading Pane. You can use the following shortcut keys to move from message to 
message: 

Ctrl + Up                    Move to previous message  
Ctrl + Dn                    Move to next message 

Changing Reading Pane Fonts 

There are three message formats for the Reading Pane: HTML, Microsoft Outlook Rich 
Text, and Plain Text. Here's how the change the text characteristics. 

HTML messages 

Change the relative size of HTML text in two ways:  

o    Click View menu | HTML Text Size. 

o    Set on via Reading Pane options (Tools menu | Options | Reading Pane tab) 

Plain text messages 

Change the characteristics of Plain Text messages:  

o    Set on via Reading Pane options (Tools menu | Options | Reading Pane tab)  
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Microsoft Outlook Rich Text 

This message format cannot be modified in the Reading Pane. 

  

Choosing the HTML Reading Pane Viewer 

What is the HTML Reading Pane? 

Messages displayed in the Reading Pane are displayed in one of three formats: Plain 
Text, Rich Text, or HTML. The HTML Reading Pane Viewer displays messages when 
they are in HTML format. 

In NEO, the default HTML Reading Pane Viewer is the Microsoft HTML Viewer . This is 
the same viewer that is used in the Outlook Reading Pane.  Our Internal HTML Viewer is 
a simpler viewer with considerably less extensive display capabilities. 

Which viewer should you use? 

We recommend that you use the Microsoft HTML Viewer. Here are the differences 
between the two.  

Microsoft HTML Viewer  Internal HTML Viewer  

Works with Internet 
Explorer versions 5.0 and 
above (not selectable with 
pre-IE5.0) 

Works with Internet 
Explorer versions 4.0 
and above. 

Displays messages just 
like Outlook does in its 
Reading Pane. 

Does not display some 
HTML objects as well. 

Faster display when 
moving from message to 
message. 

A little slower. 

Email security (see 
below) 

Email security (see 
below) 

More information about Email Security 

In general, message Reading Panes can and have been vulnerable to email viruses. 

When choosing the Microsoft HTML Viewer, NEO uses the security zone settings in 
Outlook in Options | Security. Taking it one step further, NEO also ensures scripts will 
never  run and ActiveX controls are deactivated regardless of your version of Outlook or 
security zone settings. Note that using the Microsoft HTML Viewer in the NEO Reading 
Pane is no riskier than the Outlook reading/preview pane, and may be safer. 

The Microsoft HTML Viewer is a component of Microsoft Internet Explorer. You get the 
latest version whenever you update your Internet Explorer. To minimize security risks 
Microsoft strongly recommends  that you periodically download and install the latest 
critical security updates for Internet Explorer, which can be obtained from 
http://www.microsoft.com/windows/ie/default.asp. This can be automated if you wish by 
using Microsoft's Windows Update. 
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NEO's Internal HTML Viewer is safe regardless of your version of Outlook or your security 
zone settings, but is not as rich in its display capabilities. 
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Quick Filing 
  

Using the Quick File Features 

In addition to all the basic filing methods such as dragging messages, using File to 
Folder (Ctrl+Shift+V), and Outlook Rules, NEO has two Quick File features : 

Quick File 

 

Click Quick File  on the ribbon or on the 
right-click menu (or press Ctrl+I).  

This will immediately file the message 
to your designated Quick File folder.  

Use it when you use (primarily) a single 
folder to file your messages. 

Quick File Recent 

 

Click Recent  on the ribbon or Quick File 
Recent  on the right-click menu (or press 
Ctrl+Alt+V). This displays a list of your most 
recently filed-to folders for easy selection. 

 

Use the accelerator 
keys  for quick 
selection. For 
example, pressing M 
will file immediately to 
the Meetings folder. 

You can change the 
Quick File Recent 
menu using the Clear 
List and Disable List 
Updates commands. 

Setting the Quick File designated folder 

Before using Quick File you need to designate which folder you want as your Quick File 
folder: 

1.   Right-click on any message then click Quick File Recent  | Set Quick File Folder .. 
.   

2.   Select where you want the folder created, then click New.  
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3.   Enter a name (e.g., QuickFiled or Current Year).  

4.   Click Ok then click Close . 

Changing how Backspace works with Quick File 

Backspace is an easy key to hit, so in NEO we let you assign Backspace to one of three 
frequently-used workflow operations: Make Inactive, or one of two Quick File commands: 

1.   File to your Quick File folder, or  

2.   Display the Quick File Recent menu.You can get more productivity by setting your 
Backspace key. 

If you file frequently to specific folders , 'Display the Quick File recent menu' is a good 
choice.  

If you mostly want to quickly move messages from your Inbo x, choose 'File to the 
Quick File folder'. Try each one to see what works best for you. 

Note that Backspace is an additional (surrogate) key. You can always use the permanent 
key to perform each action. For example, you might want to use these keys if you have 
assigned Backspace to Make a message Inactive. Here are the permanent keys: 

Quick File Ctrl+I 

Quick File Recent Ctrl+Alt+V 

Changing the Quick File Recent menu 

Two commands on the Quick File Recent menu allow you to manage the list of folders 
that appears on the list. 

    

Use Clear List  to remove the list of entries that have been added. Use Disable List 
Updates  to prevent new entries from appearing on the list. 

Procedure for Controlling the List 

Suppose you wanted to set a specified list so that it was unchangeable. This is particularly 
desirable when you want to use accelerator keys for selecting folders to file to. If you set 
Backspace to display the Quick File Recent menu then filing to folders is as easy as 
pressing Backspace then the first letter of the folder you want to file to.  

Here's a way to set that up:  

1.   Click Clear List  if you want it to be different that what it is.  

2.   Create your folders and file a message (a test message perhaps) to each of the folders you 
want. If you are particular about the order, file last to the folder you want on the top.  

3.   Click Disable List Updates . This will prevent future updates to the list.  

If your folders have the first initial letter, you will have to press the letter twice (or you can 
rename one of the folders). When you want to have NEO add new folders to the list, 
uncheck Disable List Updates . 
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Active Mail & To Do 

Using Active Mail 

Active Mail is an optional feature that provides an extra layer of control in managing mail. 
Active Mail is like a staging area  for your mail until you have time to read it, make a 
decision and then act on it (delete, file, etc.).  

How Active Mail works 

In NEO Pro, each message can be Active or Inactive much the same way a message can 
be Read or Unread. If a message is Active it is in the Active Mail folder, and if not it isn't. 
As with Read/Unread, you can make any message Inactive or make it Active again.  

The Active Mail folder is found in Status view but can (and should) be made Hot if you use 
Active Mail. When a message is Active you will see the Active status  in the list pane.  

When you use Active Mail, you normally use Active Mail  instead of your Inbox . 
However, unlike your Inbox where all your mail arrives, you tell NEO what new mail to put 
into Active Mail in Tools | Options | Workflow tab. If both boxes are unchecked then no 
new mail will go into Active Mail.  

Using Active Mail to implement time-management comp liant email workflow 

NEO Pro 3.2 comes with a few predefined User Interface settings. One set of UI settings 
is specifically designed to facilitate the implementation of an email workflow which is 
compliant with general time-management principles to deal in the most efficient way with 
the daily email activities. Implementing this way of working will result in an important 
reduction of actions need to manage the daily emails and create significant time-savings 
per day by relying on the available features and functionalities of both Outlook and NEO 
and combining them to optimally function together. 

For a clear explanation and guideline on how to implement this way of working please 
refer to our Knowledge Base article T1165. 

Is Active Mail better than Quick Filing to folders?  

The key feature  of Active Mail is that you can quickly say "I'm done with this message" 
without having to move the message from the Inbox (or wherever it is stored) to another 
folder. When you make a message Inactive, it disappears from your Active Mail folder but 
can still be found in NEO's virtual folders (e.g., Correspondent) and of course the Outlook 
folder it lives in. Active Mail helps many users manage their email in a way that's similar to 
how they manage their postal mail.  

You can do more operations with Active Mail in NEO (see How Active Mail is Different 
below). However, if you don't also file to folders, all your messages stay in one folder , 
typically the Inbox. That's not a problem for many users, but can be a problem if you need 
to ever read your mail outside of NEO (e.g., Outlook Web Access), or you want to work 
with your email on external systems like mobile devices where Active Mail is not available.  

Some prefer Quick File without Active Mail for Outl ook-like behavior 

If you prefer a NEO that looks and operates more like Outlook, you can choose not to use 
Active Mail (see Options | Workflow tab) - some users really like this simpler approach. 
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How Active Mail is different 

It’s like the traditional Inbox because … 

•         new mail arrives here 

•         sent mail is not included (unless you make sent make Active) 

It’s not like the traditional Inbox and other NEO folders because … 

•         you can remove messages without deleting or filing them 

     a) singly  (Backspace or F12) 

     b) all at once  (Shift+F11) 

     c) just Correspondent mail   (Shift+Ctrl+F11) 

     d) just Bulk Mail  (Ctrl+F11) 

•         you can specify to have them removed automatically on performing actions like setting 
inactive or when filed to an Outlook folder. You can set these options in the Automated 
Actions section of Workflow options. 

•         you can put messages back into Active Mail – including sent messages! 

•         the Folder Count format for Active Mail is different. You can change the Folder Counts 
format on any folder by right-clicking and choosing Properties. 

How Active Mail is like a staging area 

A way to "action" mail 

What's missing in email client programs is a way to deal with new mail that you haven’t 
had time to act on yet - the mail that piles up while you're busy in meetings. 

NEO's Active Mail is for helping to deal with that mail.  

One way to think about Active Mail 

Let’s look at the actions many people take with the physical mail they get in their 
mailboxes (i.e., their snail-mail).  

•         Flip open the mailbox and grab the pile of new mail. 

•         There's usually enough time to look at each envelope and … 

a)   throw the obvious junk mail directly into the recycle bin 

b)   open the not-so-obvious junk mail, read it and then throw it into the recycle bin 

c)   open other bulk mail (flyers, magazines), skim it, and decide to keep or recycle it 

d)   definitely bypass the bills 

e)   open and skim personal mail 

•         After a couple minutes, what's left are mail items that need more consideration before acting 
on them. They are tossed on the growing "I have to deal with this" pile. After several days of 
this, the "I have to deal with this" pile gets bigger and bigger.  

 
Active Mail is simply the "I have to deal with this " pile of email. It's our active mail - some 
read, some unread - that requires our attention soon but not necessarily immediately.  

The goal is to clear out Active Mail every few days or so, or at least keep it down to the 
ones you want right in front of you. That's not required, of course, you can let mail pile up 
in your Active Mail folder if you want, making it act more like your Outlook Inbox. 
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A simpler alternative to using Active Mail is to treat your Inbox as your staging area , and 
use NEO's Quick Filing features to file from your Inbox to other Outlook folders. 

  

Changing what new mail goes into Active Mail 

These Active Mail workflow options on the Options | Workflow tab determine what new 
mail  goes into Active Mail. 

      
  

If checked, new mail that arrives will go into Active Mail. If unchecked, NEO makes new 
messages inactive as they arrive so they don't appear in Active Mail. 

Changing the option works from this point onward 

It won't change the active status of messages already in Active Mail.  

If you want to change all Correspondent or Bulk Mail messages in Active Mail to make 
them inactive, do the following. 
  

1. Right-click the Active Mail folder. 

2. Choose from the following: 
  

     

Choosing not to use Active Mail 

Want a simpler NEO? 

Active Mail is great for users who want an extra level of control with their email. However, 
if you don't feel you need it, you can remove it to make NEO more Outlook-like. 

It's easy to configure NEO not the use Active Mail. It's all in what folders you set hot in Hot 
view. In general, you can make any folders hot, and it's ideal to make both NEO and 
Outlook folders hot. However, here are two samples - one showing a typical Hot view 
using Active Mail and a typical one not using it. 
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If not using Active Mail, you can work out of your familiar Inbox, Sent Items and Outbox. 
You may want to add in Today, Yesterday and any other folders. 

How to set NEO up not to use Active Mail? 

You can do this at any time. It's easy to switch back by reversing the process. 
1. On the Tools menu | Options | Workflow tab, uncheck both checkboxes in the Active Mail 

section. This will prevent new messages from being set Active. 

2. In Hot view, right-click the Active Mail folder and choose Reset All Active Mail (this will remove 
the Active status from each email).  

3. Still in Hot view, right-click the Active Mail folder and choose Remove from Hot (Active Mail 
will still be available in Status view). 

4. In Outlook view, right-click the folders you want to make Hot (e.g., Inbox, Outbox, Drafts, Sent 
Items, Deleted Items) and choose Make Hot. 

Switching back to using Active Mail 

You can easily switch back to using Active Mail whenever you like simply by changing 
your Workflow options back, and making the Active Mail folder Hot again. 

Using To Do 

To Do is a folder you can send mail to that you want to take action on later. 

  

How to Set or Change To Do Status 

You can: 
a) click the To Do pull-down menu on the ribbon and choose priority 

 
b) use shortcut keys: 

Alt+0       Remove priority (or Alt+`) 
Alt+1       High priority 
Alt+2       Normal priority 
Alt+3       Low priority. 

c) right-click to choose priority, or remove from To Do, or 

d) left-click drag  to the To Do folder from anywhere in NEO to set Normal priority 

To Do Status in List Pane 

To Do status is visible in every folder. In the To Do folder you may want to sort by To Do 
status. Here is what the states look like: 
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If you are in Active Mail when you set To Do status, you can specify to have messages 
removed from Active Mail automatically. You can set that option on the Workflow tab of 
Options.  
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Filtering 

Filtering Overview 

Filtering is ability to temporarily show certain types of messages. It's great for zeroing in 
on certain types messages such as Unread messages.  

Filter basics 
•         Filters are fast. They can be set and cleared very quickly. 

•         Filters are temporary. They never affect your messages, just what folders or messages that 
you see. You can always clear them. 

•         Filters are global - they operate across all message stores, views and NEO folders.  

•         Filters are sticky - if you set a filter it remains in place until you change it, even if you restart 
NEO. 

•         When a filter is 'on', the background of the List Pane and/or the Folder List show the filter 
background color to make it obvious to you. 

Use Quick Access Toolbar 
By default you will find 3 filters already on the Quick Access Toolbar (‘Read’, ‘Show Received 

Messages’ and ‘Show Sent Messages’). If you (like to) use other filters frequently, go to the  

Filter tab, right-click these filters and select Add to Quick Access Toolbar. 

Filtering in NEO Pro 

 

NEO Pro has a Filter tab on the ribbon. The Filter tab contains filter sets that fit together 
logically. You can combine your filters in any combination that you like. 

Following filter sets are available: 

  

 

Filter Controls:   Clear clears the filter so 
that all messages show. Disable, temporarily 
clears the filter so you can quickly see all the 
messages. Clicking Disable again reinstates 
your current filter. 

  

Folder:   Shows only folders  with Unread 
and Active messages respectively. These 
two filters are folder filters and act on the 
Folder Lists. 
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Message Class:   Correspondent or Bulk 
Mail messages. These toggle - setting one 
clears the other. 

 

Message Status:   Choose from Unread, 
UnFiled, Active, To Do, Flagged or 
Important, singly or in any combination. 
Pressing Shift+Unfiled will show all 
messages that are ‘Filed’ in current view. 

  

Recipient:  These relate to how your 
address is in message recipient lists: In 
order, 
  Exclusive To -  you are in the To alone. 
  To - you are in To alone or with others. 
  Cc - you are in Cc or Bcc alone or with 
others. 

  

Direction:   Show Received messages only 
or Sent messages only. 

  

Date filter:   A flexible From… To… filter. 

Message age in Days :  Message age from 
today. 1 day shows today's messages, 2 
days shows today's and yesterday's 
messages, and so on. 

If using the Correspondent and Bulk Mail filters 

For your convenience, when in Correspondent or Bulk Mail view, the Correspondent and 
Bulk Mail filters are ignored.  

Note also that if you use the Correspondent filter in Outlook view you won't see any 
incoming Bulk Mail. In that case, please ensure you go to Bulk Mail view regularly to see 
what new mail has arrived there. See things to do each day. 

How to tell when a filter is on 

Whenever a filter is on, the background color of parts of NEO display in a different color. 
For folder filters ('Show folders with Unread' and 'Show Folders with Active..'), the Folder 
List background color is changed. For message filter sets (all others) the List Pane 
background is colored. You can change the background color in options. 
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New Mail Alerts 

Working with New Mail Alerts 

In NEO you are notified on your desktop when new mail arrives. Like the phone system's 
Caller ID feature, this lets you know who has just sent you email whether NEO is your 
active application or not. 

You can choose to show a tray icon , show a popup , and/or play a sound independently 
for each of your Hot  mail class folders, Correspondent  folders or Bulk Mail  folders. 

For example, you might want to be alerted with an icon, popup and sound for your Hot 
correspondents, just show icon and popup for correspondents, and show nothing for Bulk 
Mail. 
  

Setting the New Mail Alert options 

Set the New Mail Alert options via Tools menu | Options | New Mail Alerts tab. 

Working with the Tray Icon 

When you have opted to hide NEO when minimized, you will find NEO’s default icon  in 
the System Tray when minimized. 

The tray icon changes whenever new mail arrives. The color of the icon indicates the 
highest class of the messages that have recently arrived:    Hot,    Correspondent or 

  Bulk Mail. If the Tray Icon appears after returning to your desk, click it to display the 
Popup .  Right-click it for other actions: 
 

            

Working with the Popup 

The Popup appears whenever new mail arrives. It displays the 10 most recent messages 
for 30 seconds.  
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Click an entry to jump to the folder in either Correspondent or Bulk Mail view. 

Resetting the Popup 

Until the popup is reset, you can display it by clicking the tray icon. You may want to do 
this after returning to your desk. 

You can manually reset (clear) the popup by clicking the  x  on the popup or by right-
clicking the tray icon and choosing Reset. If you don't reset it, it will disappear after 30 
seconds. 

The popup is automatically reset by NEO whenever you perform any one of the following 
operations on any email message (not just the ones in the popup): delete, open, make 
inactive/make active, mark read/unread or mark/clear ToDo.  

When a reset action takes place, all messages in the new mail list are cleared and popup 
will not appear again until new mail arrives. 

  



P a g e  | 76 

Folder Lists 

Overview to Folder Lists 

Each NEO view has its own Folder List. When a folder in the list is selected its messages 
are displayed in the List Pane. 

    

Folder Basics  

Folders are containers for your messages. The operations you can perform on folders 
vary depending on the type of folder. To see the available operations for a folder, right-
click the folder . Here are the available operations for a Correspondent folder: 
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Common folder operations 
Make Hot                   Make any folder available in Hot view - Ctrl+H.  

Search in folder         Go to Search view with the folder selected for searching. 

Move folder               Move to another folder or top-level folder within a view - Shift+Ctrl+V . 

Combine folders        Combine one folder with another. You can also drag and drop the source 
folder onto another. 

Remove folder           Delete a folder without deleting the underlying messages - Alt+Del . 

Delete folder              Delete a folder including the messages in it - Del. 

Rename folder           Change the name of a folder - F2. 

New folder                 Create a new folder - Shift+Ctrl+E .  You can often choose between a 
folder and a group folder. 

Folder properties        View the folder properties - Enter  or double-click . 

Special folder operations 
Empty folder              Permanently delete the folder's messages (available for Deleted Items and 

Spam Senders).  

New message to        Compose a new message using one of the email addresses of a 
Correspondent or Bulk Mail folder - Ctrl+E . 

Open Contact             Open or create (with confirmation) an Outlook contact based on the email 
addresses of a Correspondent or Bulk Mail folder - Shift+Ctrl+O . 

Make Current              For views containing the New, Current, Dormant folders, move folder into 
the Current area. 

Make Dormant            For views containing the New, Current, Dormant folders, move folder into 
the Dormant area. 

Change to Corresp     Change class of a Bulk Mail folder to Correspondent. 

Change to Bulk           Change class of a Correspondent folder to Bulk Mail. 

Reset Active Mail       For Active Mail folder, Reset all Active Mail (Shift+ F11 ), reset 
Correspondent Active Mail (Shift+Ctrl+F11 ), or reset Bulk Active Mail 
(Ctrl+F11 ). 
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Refresh search           Re-run a search folder to update it based on its search parameters. 

Jump to Outlook        Jump to the corresponding Outlook folder. Do this for Contacts, Calendar, 
etc. as well as your user-defined folders - Enter  or double-click . 

Finding Folders in the List 

The fastest way to find a folder in long Folder Lists is to use the Folder List Filter. Enter 
characters into the textbox at the top, and the list will display only those folders with the 
characters in it. 

For example, to quickly find Mary Jennings folder, entering 'mary' is sufficient to reduce 
the folder set to a small enough set to select it. 

 

    

Notice that when a filter is in effect, the background is displayed in the filter background 
color.  

Here are some shortcut commands to make working with the Folder List Filter easier: 
Esc             Clear the Folder List Filter 

F3              Jump to the Folder List Filter in the current view 

Ctrl+F3        Jump to the Correspondent Folder List Filter. 

Sorting the Folder List 

Each view can have its own sort order. Change the sort order by clicking one of the three 
buttons at the top right. 
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Expanding and Collapsing the Folder List 

When in Tree Sort Order, the tree displays in a hierarchy. Expand a branch by clicking the 
Plus  symbol. Collapse a branch by clicking the Minus  symbol. 

Keyboard shortcuts (using the number keypad): 
Num +                    Expand current folder in Folder List 

Num -                     Collapse current folder in Folder List 

Shift+Ctrl+Num +   Expand all folders from anywhere in list 

Shift+Ctrl+Num -    Collapse all folders from anywhere in list 

Top-level folders - New, Current, ... 

Some views have top-level folders. Top-level folders are folders managed automatically 
by NEO to help you organize your folders. You can also organize folders in top-level 
folders manually. 

For example, in Correspondent and Category views the New top-level folder displays all 
folders that have been newly created. In the case of Correspondents, it is very helpful to 
isolate new correspondents so that you can decide how you want to organize them (e.g., 
delete or move to the Current top-level folder). In the case of Categories, the New folder 
displays categories set by others. 
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Automatic organization 

You can choose to have NEO automatically move Correspondents from New to Current, 
and from Current to Dormant based on day-age parameters you provide.  You can also 
specify that Dormant folders are moved back to Current when they become active again 
(e.g., receive a message). 

You could specify that New folders automatically move to Current after 30 days, and 
Current folders automatically move to Dormant after 365 days of inactivity. A folder 
remains inactive until a significant event occurs such as it receives a message.  

By disabling automatic moving of folders you would retain complete control over where a 
folder is located. 

To set the automatic organization of folders, right-click a top-level folder such as New, 
Current and Dormant and choose Folder Properties. 

Manual organization 

You can manually move folders from New to Current, Current to Dormant and so on in two 
ways: 

1. Drag and drop the folder from one group onto the branch  of the other. Drop it on the top-level 
folder itself (e.g., Current). It you drop it on a folder, NEO will think you wish to combine 
folders. 

2. Right-click the folder and choose Make Current  or Make Dormant . 

Folder Groups 

You can create folders groups to help organize other folders. Folder groups can be 
created in any view except Hot and Outlook views. Folder groups always contain folders 
and behave just like any other organizing folder. 

Here is an example showing two folder groups (Aquila and Tennis) in Correspondent 
view. 

            

In Correspondent view folder groups are useful for organizing by company. In Category 
view folder groups are ideal for organizing all your categories. 

Adding a folder group 
1. Right-click anywhere in a Folder List when sorted in Tree order and choose New Folder  (or 

press Shift+Ctrl+E). 



P a g e  | 81 

2. If in a Correspondent (or Bulk Mail) Folder List, choose Group folder  in the option group at 
the top: 
 

    

3. Enter the folder name : 
 

  

Deleting a folder group 
1. Right-click the folder group and choose Delete Folder . 
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Folder Properties 

  

General Folder Properties 

These properties apply to all Status folders (e.g., Active Mail, Unread), all Date folders 
(e.g., Today, Yesterday), Category, Attachment and Search folders. 
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Top-level folder properties 

Top-level folders group your folders at the highest level. 

  

  

Group folder properties 

Group folders contain other folders, but not messages.  
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Correspondent or Bulk Mail folder properties 

Correspondent or Bulk Mail folders are identical in nature. 
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Spam Senders folder properties 

Spam Senders folder properties is where you can change, add, move and remove spam 
sender addresses or address patterns. 
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Unsorted Bulk Mail Properties 

Unsorted Bulk Mail is a special folder. It's where all new Bulk Mail arrives until you take an 
action to create a Bulk Mail folder for it.  

Note that you can't enter name information or addresses the Unsorted Bulk Mail folder. 
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Outlook Folders 

Overview – Outlook Folder List 

Outlook view is your view into your Outlook Folder List. 

 

Your mail folders:     Your user-
defined mail folders in this pane are your 
actual Outlook folders. You can add, 
delete, copy, move and rename these 
folders here just as you would in Outlook. 
 
Outlook folders:      Your special 
Outlook folders such Drafts, Deleted Items, 
etc. are also here. 
 
Non-mail folders:      You can interact 
with non-mail folders. For example, you 
can drag and drop a message onto the 
Calendar to create an appointment. 

  

 
Make them hot!   if you refer to any of these often, it's helpful to make them hot so that 
they also appear in Hot view. 

Making Outlook folders hot 

You can make Outlook hot just as you can make any NEO folder hot. To make a folder 
hot, right-click and choose Make Hot (or press Ctrl+H). 

Folders to consider making hot are any folders you use regularly. These could include: 

•         Non-mail folders 

•         Drafts 

•         Outbox 

•         Sent Items 

•         Inbox 

•         any user defined folders you have created 

•         Deleted Items 

Tip :    If you make the folders you use most often hot, then you may not need to have 
Outlook view open.  

Note : When making Outlook folders Hot which are from non-default message stores, the 
message store name will show behind the Outlook folder name in the Hot view (e.g. 
‘Deleted Items in Archive 2009’). You can switch this off (to only show the Outlook 
folder name) by going to Tools | Options | Format tab – restart NEO after changing 
this selection. 
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Working with user-defined folders 

You can create your own folders in NEO, and the folders you create in Outlook are visible 
to you here. In fact, the folders in Outlook view are your actual folders in Outlook. 

Viewing user-defined folders in NEO 

Simply select any folder in the Outlook view, just as you would select any folder in the 
NEO views. 

Moving messages to Outlook folders 

Move any message from anywhere in NEO to your user-defined folders. Simply drag and 
drop the message(s) onto the folder, or press Shift+Ctrl+V. 

Copying messages to Outlook folders 

Right-click drag the message to a user-defined folder. When you release you will be 
prompted as to whether you want to copy or move. 

Using the Outlook Rules Wizard 

You can continue to use the Outlook Rules Wizard to automatically update your user-
defined folders. For information on using the Rules Wizard, see the Microsoft Outlook 
Help. 

Adding, deleting, copying, moving and renaming fold ers 

As with Outlook, just right-click the folder and choose the action you want to take. Not all 
actions are available for all folders. 

Working with non-mail folders 

Drag and drop email to non-mail folders 

You can drag and drop messages to non-email folders such as Calendar, for example to 
create a new appointment based on the email. 

Open non-mail folders in Outlook from NEO 

Double-click non-email folders to open Outlook into Tasks, Notes, etc. 

Other ways to interact with Outlook from NEO 

•         Select a message then right-click  and choose Open Contact.  

•         On the toolbar, click "Outlook"  to go to Outlook or click the down arrow to open into Outlook 
areas. 

•         Use an Outlook keyboard shortcut such as Shift+Ctrl+A  to open a new appointment. 

Excluding folders from being organized in NEO 

You can exclude messages from Outlook folders from being organized into NEO folders 
(e.g., Correspondent, date folders, etc.). 
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You would typically do this for Spam folders, but you can also do it for any folder that you 
won't want to see in NEO. Exclusion works only for new messages. That is, if you set it 
now it will only apply to messages you get from this point onwards. 

To change the Exclude setting: 

1.   Right-click on the folder in Outlook view. 

2.   Select Folder Properties. 

3.   Set the option in the Exclude from NEO section. 

Note that by default, Excluded messages are included in NEO searches. However, you 
can optionally choose to search all folders except Excluded and Deleted Items. 
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Correspondents 
& Bulk Mail 

Overview 

Overview 

All mail in NEO is organized into one of two classes - Correspondent or Bulk Mail. This 
high-level sorting by mail class is done on the premise that you will want to view your 
Correspondent mail throughout the day, and view your Bulk Mail when you have free time.  

NEO puts these two classes into their own View tabs. Also, Correspondent and Bulk Mail 
filters allow you to show/hide one or the other throughout NEO. 

By default NEO places all email into Correspondent Folders. From here you can re-
organize messages into Bulk Mail folders (see below). 

If you allow NEO to automatically assign Bulk Mail, it uses email addressing types to 
guide its initial class organization. All new mail is then classified as follows: 

Direct mail         NEO creates Correspondent  folders for all new messages directly between you 
and another person (or slots it to an existing Correspondent folder). 

All other mail     Goes into the Unsorted Bulk Mail  folder in Bulk Mail (unless you tell NEO to put 
it elsewhere). This typically includes mailing lists, e-zines and announcement 
mail but also includes spam that is sent to you indirectly. 

NOTE: Allowing NEO to assign automatically Bulk Mail is done when creating (or 
rebuilding) a catalog. The user can opt to assign emails automatically to the Unsorted 
Bulk Mail folder (default is off). When doing so, NEO will classify all messages according 
above class organization placing Bulk Mail into the Unsorted Bulk Mail folder. From here 
users can re-organize message from their Unsorted Bulk Mail folder into individual Bulk 
Mail folders or back to Correspondent. 

A class folder must be one of Correspondent or Bulk Mail. However, a message can be 
organized into both a Correspondent folder and a Bulk Mail folder.  

After the initial organization into Correspondent Folders, users can further enhance their 
email organization: 

•         Combine your Correspondent folders . NEO can't tell that email from two different 
addresses is in fact from the same person, unless the same email name is used. 

•         Create your own Bulk Mail folders  from the mailing lists, e-zines and announcement mail 
that NEO has placed into Correspondent Folders. 

•         Create Bulk Mail folders for other emails based on Rules  using words in (part of) the 
subject to classify messages as Bulk. Rules can be found on the Tools tab of the ribbon. 

•         Change class  - change a folder from Correspondent to Bulk Mail and vice versa. NEO 
initially assigns a class but you easily can change it. 

•         Organize your similar mail together . In addition to having more than one address for a 
folder, you can create address patterns to, for example, collect into a folder all email from a 
particular domain. Further, you can create Group Folders to organize related class folders 
together. 
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Correspondents Overview 

All your mail is initially organized automatically b y Correspondent 

NEO automatically creates Correspondent folders as you communicate with new people. 
All subsequent messages are automatically filed by correspondent. 

These are virtual folders . The messages are seen here in addition to the Outlook folder 
they are permanently stored in. 

 

  

  

Both Sent and Received 
messages are shown 
together. 

When sorted in Tree view, you 
will find new Correspondents 
arrive into the New area. You 
can manually move folders to 
Current  or the Dormant  
areas. Default sorting is in 
alphabetical order to quickly 
find your Correspondent. 

In Tree view you can set 
parameters to have the 
Correspondent folders move 
automatically between 
levels  according to message 
activity based on date. 

 
Housekeeping tasks such as renaming and combining (to consolidate multiple email 
addresses for one person) are most common. How much work you put into keeping your 
list up to date is up to you - none of it is strictly necessary. 

Exporting Correspondent Details 

Details of all correspondents (like name and email addresses) can be exported from NEO 
Pro into a CSV file by going to Application Button | Export Correspondent Details. 

For non-licensed (evaluation) users limited to maximum of 25 correspondents. 

Bulk Mail Overview 

What is Bulk Mail? 

Bulk Mail is there for all your non-correspondent  mail. Some users think of bulk mail as 
analogous to the "To the Householder" paper mail they receive - it finds its way to their 
mailbox but is addressed indirectly. 

You can also assign emails to a Bulk Mail folder based on NEO Rules (Rules can be 
defined from the Tools tab). 

By default NEO will organize all messages into Correspondent Folders leaving the 
Unsorted Bulk Mail  folder empty. 
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When allowing NEO to assign Bulk Mail automatically it puts new bulk mail into your 
Unsorted Bulk Mail  folder in Bulk Mail view. From here you can further organize it into 
individual Bulk Mail folders. You can decide to use automatic Bulk Mail assignment when 
creating or rebuilding the catalog. 

How to manage it? 

So why organize your indirect messages into Bulk Mai l folders ?  Suppose you 
subscribe to e-newsletters and you like to read them 'off hours'. With NEO filtering you 
can choose just to see your Correspondent mail when in your Hot, Outlook and other 
views so you won't be interrupted by new Bulk Mail when it arrives. If you get lots of bulk 
mail that can prevent a lot of distractions. When using Active Mail as alternative for your 
inbox, you can even decide not to make Bulk Mail active hence only your direct 
Correspondent mail will show up in Active Mail. 

Creating your own Bulk Mail folders 

If you have indirect messages in your inbox which you like to organize separately into a 
Bulk Mail folder, right-click the message and choose Reorganize Message  (see creating 
Bulk Mail folders). 

 

Email addressing types explained 

You probably get email of all kinds: correspondence with others, mailing lists, 
ezines/newsletters, announcements and of course junk mail.  

It helps to understand what each of these are because you'll probably want to manage 
them differently. Most users think of their direct correspondence as having the highest 
priority, bulk mail such as mailing lists as a lower priority, and junk mail as a big nuisance. 

How email addressing determines email type 
Direct email       Your email address is explicitly in one of the recipient fields (i.e., To or Cc). This 

is your normal business and personal correspondence. 
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Indirect email     Your email address is not  in one of the recipient fields (i.e., To or Cc). Instead 
your address is in the message transport header (not normally displayed). You 
receive the message because the sender told their email server to send the 
same message to everyone on a list (one that you are on). 

Think of the mail you get through your postal service. Mail with your name specifically on 
the envelope is direct mail; mail that says To the Householder is more like Bulk Mail. 
Whether it's important to you or not is up to you. 

How NEO classifies email 

By default NEO organizes all messages into Correspondent folders. However, NEO can 
automatically classify your mail into one of two classes based on whether the addressing 
is direct or indirect.  

Correspondent Mail 

All direct email (your address is in the recipient list). Examples include: 

•         Normal business and personal correspondence directly addressed to you. 

•         Junk mail (e.g., pornography) that's directly addressed to you.  

Bulk Mail      

When you specify NEO to assign Bulk Mail automatically, all indirect email (where your 
address is not in the recipient list) goes into Unsorted Bulk Mail (unless defined 
otherwise). Examples include: 

•         Subscription (non-junk bulk mail) indirectly addressed to you:  

a)   Announcements - messages sent from one person to many (usually on an intermittent 
basis) 

b)   Ezines/newsletters - messages sent from one person to many (usually on an regular 
basis) 

c)   Mailing lists  - messages sent from many people to many (usually many per day) 

•         Junk mail that's indirectly addressed to you. 

Notes: 
1. Even though NEO does this automatically, you can reorganize a correspondent as bulk mail, 

and bulk mail as a correspondent. 

2. When you do not specify this specifically NEO will not to perform this initial assignment and 
thus organizes everything under Correspondent (during creation of the Catalog). 

3. As you can see, junk mail can be both directly addressed to you or indirectly addressed to 
you, and thus can appear in both Correspondents and Bulk Mail.  

4. Once classified, NEO automatically creates or updates Correspondent and Bulk Mail folders. 

How and when NEO creates class folders 

Correspondent Mail 

Correspondent name folders are automatically created and messages put into them as 
follows: 

• Persons you send messages exclusively to; that is, people who are in the To field of 
messages you send. 

• Persons who you receive mail from where your email address is anywhere in the sender’s 
To or Cc fields. NEO automatically adds a new address to an existing Correspondent folder 
if the address name matches the name of an existing folder. 
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• If not specified otherwise: All indirect messages go into Correspondent folders which 
otherwise would be organized under Unsorted Bulk Mail.  

Bulk Mail 

When specified as such, Bulk mail is default location where mail that is indirectly 
addressed to you initially goes; that is, where your address is not in the message header 
information. 

• NEO doesn't create individual Bulk Mail folders automatically. You can and should create 
your own bulk mail folders. This can be done based on Addressing or based on Rules.  

• Correspondent status takes precedence over bulk mail when filtering if the message is 
classed as both Correspondent and Bulk Mail (so that potentially important messages are 
brought to the forefront).  

 

Keeping Your Addresses Up to Date 

About Your Addresses 

NEO needs to know which addresses are yours in order to automatically organize your 
messages. If all your addresses are not entered, your messages will not appear correctly.  

Note that NEO must know all your addresses  - not just your currently used ones. Be 
sure to include your old addresses if you have messages that used them.  

Auto-detecting your addresses on catalog creation 

NEO automatically detects your addresses when you create a catalog, and you can add to 
the list NEO auto-detects. Addresses you enter are displayed in bold.  

Important Note :   NEO does not auto-detect addresses you use after creating the 
catalog. You have to enter these manually. 

Adding and removing addresses 

You can add addresses and you can remove addresses you add. Addresses NEO auto-
detects can not be removed - however, you can choose not to include them by 
unchecking them)  

Click Application Button menu | Your Addresses: 
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To add an address, click the Add command. POP3 email addresses are entered in the 
usual way (e.g, bcoopersmith@fbi_NY.com). Exchange Server addresses are enter in 
X.500 format. 

Creating Folders 

Reorganizing Correspondence / Bulk Mail and using NE O Rules 

Reorganizing messages based on Addressing 

Reorganizing a message simply means creating a Correspondent or Bulk Mail (class) 
folder.  

Right-click the message anywhere in NEO, and choose Reorganize Message (or press 
Ctrl+Shift+E). 

There are three basic steps: 
Step 1  Decide on mail class  - Correspondent or Bulk Mail (generally Bulk Mail is for mailing 

lists, e-zines, etc.). 

Step 2  Choose the folder behavior, addresses  and destination . 

Step 3  Perform the re-organize action. 

When done, NEO will automatically organize similar messages into the folder, and will 
automatically file all new messages in that folder.  

The example below shows creating a Bulk Mail folder for the Outlook Exchange mailing 
list. After subscribing to this mailing list, these messages appear in the Inbox organized in 
a Correspondent Folder. After reorganizing it into a Bulk Mail folder called ‘Outlook 
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Exchange’, NEO auto-files all existing and new messages to this folder. If you now file 
these messages outside the Inbox they all remain available in the (virtual) Bulk Mail folder 
‘Outlook Exchange’ (completely independent of their actual location in the Outlook folder 
system). 

To start, right-click the message, choose Reorganize Message , then follow these three 
steps: 

Step 1  -  Choose Correspondent or Bulk Mail class 

  

Step 2  -  Choose behavior, address and destination 
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When you click Create New, the following appears. Choose a folder name to your liking. 
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Step 3  -  Perform the re-organize action 

 

 

Reorganizing messages using NEO Rules 

Although email addressing is well suited for reorganizing most types of indirect messages, 
sometimes it is better to reorganize messages into Bulk Mail folders based on (certain 
words in) the subject. This is especially true within companies where distribution lists are 
used to distribute general information. These mailings generally have a fixed subject but 
are usually send by an individual also involved in other email correspondence. In this case 
it is not really appropriate to link the email address itself to the Bulk Mail folder as other 
emails from this address need to be captured under the person’s Correspondent Folder. 

For these and other type of messages NEO Rules can be used to assign them to a Bulk 
Mail folder. NEO Rules can be accessed through Tools | Rules. 

In organizing incoming messages, NEO Rules takes precedence over addressing 
assigned to Correspondent or Bulk Mail folders. Defined Rules are executed first – when 
no rule is applicable for the subject of the message, the normal Correspondent and/or 
Bulk Mail assignments are executed. So, even when an address is assigned to a Bulk 
Mail folder, a Rule can be defined to direct a part of the incoming messages into a 
dedicated Bulk Mail folder based on the subject.  

Working with NEO Rules 

To create a new rule, select Rules from the Tools menu. This will open following dialog 
screen. With multiple rules defined, the Rules window can be resized in height or sorting 
can be applied to any column. 
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To create a new rule or edit an existing one, click “Create new…” or “Edit rule…” and click 
Bulk Mail: 

 

Rules can be kept in the system without being executed by deselecting the “Rule Active” 
mark.  

“Case sensitive” can be used to limit the rule only to the exact string provided under 
Subject matching the upper/lower case characters. 

Under “Scope” it can be defined whether the rule applies to incoming messages, outgoing 
messages or both. 
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Under “Subject” the words to be looked for in the subject are entered. This can be a single 
word, several words or the entire subject – the more specific the rule is defined (or 
combined with “Case sensitive”) the less likely unwanted messages will be moved to the 
assigned Bulk Mail folder. 

Finally a Bulk Mail folder needs to be created or assigned to organize the messages into. 
This is done by selecting the appropriate button under “Destination folder” which behaves 
the same as outlined above. When no folder is assigned the rule cannot be completed. 

Click OK when finished or Cancel to exit. 

TIP: To distinguish Bulk Mail folders based on rules from Bulk Mail folders based on 
addressing, it is advised to give a fixed preface (like “Subj:” or “Rule:”) to the name of the 
Bulk Mail folder (e.g. “Subj: monthly report” as name for a rule based Bulk Mail folder). 
Additional advantage is that all Bulk Mail folders based on rules will show underneath 
each other in the Bulk Mail folder list. 

Executing NEO Rules 

Following describes how Rules are being executed: 

• New rule: When a new rule is created, it will initially only  be applied to new, 
incoming messages – without further action nothing will change for already 
received messages. 

• When a new rule needs to be applied to existing messages, select the rule and 
click Execute Rule. 

• When an existing rule is edited, it will be executed immediately on all existing 
messages (e.g. when Rule Active is deselected, all messages will be reorganized 
into their normal Correspondent or Bulk Mail folders when selecting OK in the Edit 
Rule dialog; making the Rule Active again, will reorganize them again into the 
assigned Bulk Mail folder). 

• Executing a rule will be preceded by an “Update Word Index” to also reorganize 
recently received messages.  

• Executing rules will be done in background – progress can be monitored in the 
lower-right status line. 

Choosing Behavior and Address 

Choosing Behavior 

Generally you should use Direct  for messages between you and another person and 
Subscription  for messages such as mailing lists, e-zines, and announcements. 

Some subscriptions are actually directly addressed to you, in which case you can choose 
Direct or Subscription. 

Choosing Address 

Choose the address that best describes the correspondent or subscription you are 
organizing.  

For Correspondent  messages it is generally the person you have received the message 
from, or to whom you are sending the message - but shouldn't be you. 

For Bulk Mail  messages it is generally the name of the subscription. You may also see 
the name of the person sending the message. It's usually better to pick the more general 
subscription name rather than more personal-sounding names. If in doubt, you can often 
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determine the correct address by comparing two emails and seeing what address is 
common to both. 

Address that are in 'Your Addresses' list are indicated with a checkmark to help you keep 
your addresses up to date. If you see one of your real addresses that doesn't have a 
checkmark, you should click Advanced then choose Your Addresses to add it. Likewise, if 
you see an address that is checked but which isn't one of your read addresses, you 
should click Advanced then choose Your Addresses to remove it. 

  

Advanced Addressing Settings 

The features on this dialog are not normally required.  

If you choose to disable Optimize Processing, it is only disabled for the current 
reorganization operation (it automatically resets back to Optimize Processing for 
subsequent reorganizations). 

    

Working with Correspondents & Bulk Mail 

Keeping name folder information up to date  

As you correspond with new people, new Correspondent folders will automatically be 
created for them and will appear in your New top-level folder. NEO creates the name 
information for you. 

In many cases, however, not enough information is provided and the name folders will 
simply be email addresses. In other cases, NEO may interpret the name and organization 
incorrectly. 

If you wish, and this is entirely optional , you can configure your names as they arrive. 

How to update correspondent names 

1. Quickly change a name  in the Folder List by selecting the name and pressing F2. Then edit 
the name.  Alternatively, you can right-click the folder and choose Folder Properties.  
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2. You can quickly combine two names  together by dragging one name into another name in 
the View pane, or you can right-click the folder and choose Combine Folder. 

Combine two names / folders 

You will want to combine two names together when someone you correspond with has 
more than one email address. 

You can combine class folders whether they are Correspondents or Bulk Mail. 

When you combine names, you select the name you want to combine and then select the 
name you want to move it to. The first name disappears, and the second name gets the 
address(es) from the first name. 

Combine names using drag and drop 

In the View pane, drag the name you want to combine onto the name you want to 
combine it into. 

Combine names using the Combine Folders command 

Alternatively, you can right-click the folder you want to combine into another folder, then 
click Combine Folders .  You'll then be able to choose the other folder to combine it into.  

Updating address information 

The Correspondent or Bulk Mail folder's addressing information is entered on the Folder 
Properties for the folder. To get there, right-click the folder and choose Folder Properties  
(or double-click the folder). 

Addressing for the folder is entered in the following section of the Folder Properties. 

     

Adding and changing address information 

Click Add or Change . You can add as many addresses as you like. The same address 
can be in more than one folder.  

Moving an address to another folder 

Move an address out of a folder to another folder by highlighting the address or address 
pattern clicking Move.  

Your Folder List will appear. On it you can move to an existing folder in the Folder List by 
highlighting it and clicking OK, or you can add a new folder by clicking the New command 
at the bottom.  

Note that if you move an address back to Unsorted Bulk Mail it will only move there is it is 
identified by NEO as Bulk Mail. If it doesn't appear there, then look for it in 
Correspondents view. 
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Removing an address 

Highlight the address or address pattern you want to remove and click Remove . Remove 
never removes or deletes messages. It just removes the address from the current folder. 
The messages related to the address will then be auto-organized again by NEO and may 
appear in Unsorted Bulk Mail or in a Correspondent folder. 

  

Entering Email Addresses and Names 

     

Entering an address 

Enter SMTP addresses (e.g., jkwan@prime.com) or X.500 addresses. If entering X.500 
addresses, it's easiest to use the Lookup User command. Exchange addresses are 
normally displayed using the address name and is often underlined. 

Entering an address pattern 

You can enter address patterns for SMTP addresses. A pattern may contain any 
combination of the wildcard characters * or ?. A * will match any number of characters and 
a ? will match any single character. 

Patterns apply to the part of the address before the @ symbol (they don't apply to the 
domain portion). Patterns can also apply to address names (with a Name= prefix). 

Example patterns: 

*@caelo.com Represents all addresses with a domain of caelo.com 
such as support@caelo.com, affiliate@caelo.com and 
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so on. 

jk*@prime.com Represents addresses starting with jk at the 
prime.com domain: jk@prime.com and 
jkwan@prime.com. 

jk?@prime.com Represents addresses starting with jk at the 
prime.com domain with exactly 3 characters before the 
@ sign: jk1@prime.com and jk2@prime.com but not 
 jtkkwan@prime.com. 

CNET_*@newsletters 
.online.com 

Ideal for capturing emails that change each time: 
CNET_#3.106@newsletters.online.com,  
CNET_#3.503@newsletters.online.com, and 
CNET_#3.618@newsletters.online.com 

Name=Outlook* 
@online.com 

Represents all address names beginning with Outlook 
at the online.com domain:  Outlook-
Users@online.com, Outlook-Developers@online.com 
and Outlook-Administrators@online.com 

Choosing behavior 

Generally you should use Direct  for messages between you and another person and 
Subscription  for messages such as mailing lists, e-zines, and announcements. 

Some subscriptions are actually directly addressed to you, in which case you can choose 
Direct.  

Adding, deleting, renaming name folders 

Adding a name folder 

Right-click on one of the names and then choose  New folder (Ctrl+Shift+E). 

Deleting a name folder 

Right-click the folder you want to delete and choose Delete Folder  (Ctrl+Del). All 
messages contained in the folder will also be deleted. 

Note :    Messages you delete here will be removed from other name folders that were also 
correspondents to these messages. 

Renaming a name folder 

Right-click the folder you want to rename and choose Rename Folder  (F2).  Enter the 
new name. Names are automatically formatted according to the name format you have 
specified in the Format options.  

Changing Correspondent folders to Bulk Mail and vic e versa 

You can achieve this in either of two ways: 
a) Right-click on the folder  to change then click Change to Correspondent or Change to Bulk 

Mail , or  

b) right-click any message  from the folder you want to change and choose Reorganize 
Message  (or press Ctrl+Shift+E). 

Unsorted Bulk Mail 

If you let NEO automatically organize indirect mail into Bulk Mail, all your bulk mail goes 
initially into your Unsorted Bulk Mail folder. 
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Creating Bulk Mail folders 

Example of Bulk Mail is subscription mail - mailing lists, e-zines and announcements.  

You may not have any subscription type mail, but if you do you will probably want to 
create a Bulk Mail folder for it so that all existing and future mail for that folder will 
automatically be filed there. See Reorganizing Correspondence / Bulk Mail above. 
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Categories 

About categories 

What are Categories 

Categories are words or phrases that you can define and use to keep track of related 
messages. When you add the same category to more than one message they are 
displayed together in an auto-created category folder in Categories view. 

Many people use Outlook folders to organize messages by project or topic, but categories 
are much better because you can assign more than one category to a message 
(something you can't do with Outlook folders unless you copy the message).  You can 
continue to file messages to Outlook folders - categorized messages display together 
regardless of the folder they are filed in. 

NEO categories are Outlook categories 

If you set a category for a message in NEO, it appears for the same message in Outlook 
and vice versa. NEO and Outlook categories are one and the same. For additional 
information about categories and how they are used in Outlook, see Outlook's Help. 

How NEO categories are different 

NEO's categories look like Outlook categories but there are important differences in how 
they behave: 

Category 
folders 

NEO categories are stored in Category folders. Click a folder in Category view 
to see the messages in it, or make it Hot. 

Easier to 
manage 

When you edit a category, the category itself is also edited in all the messages 

- you can easily edit, split and merge your categories. NEO categories have 
referential integrity! 

Easier to 
organize 

In Category view, category folders are auto-organized into New, Current and 

Dormant top-level folders. You can also add your own Group folders for further 
organization. 

Easy to 
set  

The categories "picker"  is on the toolbar and the Reading Pane (Ctrl+T). 
You can enter Categories directly into the Reading Pane (Shift+Ctrl+T). 

Categories and Outlook 2007 

With Outlook 2007 Microsoft introduced color-coded categories. In fact they moved from 
using colored flags to colored categories. Flags within Outlook 2007 are now used 
exclusively to set Follow-Up reminders and their color (which only comes in variants of 
‘red’) is fixed based on the timing of the Follow-Up. 

NEO continues to use the uncolored version of Categories as this is a much better way to 
organize messages along the lines of a project, topic or client than the classical way of 
using folders. Colors in this respect are less useful.  

In addition NEO continues to provide the Flags in the different colors as under Outlook 
2003 to maintain compatibility and to provide additional flexibility for users to define their 
own meaning for the flags they set as Follow-Up or as Reminder. 

In other words, NEO is providing consistency in the use of Categories and Flags. 
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Categories in Category view 

The categories in Category view are those to which you have assigned messages. You 
can also create empty categories and assign messages to them later. 

Categories are organized into New, Current  and Dormant  top-level folders to make them 
easier to work with. 

  

There's no notion of Master Categories in Category view. The Master Category List is just 
for picking categories in the catalog picker (use of it is optional). 

Master and user-defined categories 

In NEO, the categories you assign may be ones you define, or they may be ones you pick 
from the Master Category List.  

Regardless of whether they are defined by you or picked from the Master Category List, 
once assigned to messages there is no difference between a master or user-defined 
category. 

Master categories 

There's really nothing complicated about master categories or the Master Categories List. 
The "list" is simply a list of categories stored in your registry. Outlook delivers a list to get 
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you going, but you can and should improve on it if you plan to use Master Categories at 
all. 

At best the Master Categories List serves as a pick list from which to choose regularly 
occurring categories.  

User-defined categories 

There is no limit to the number of categories you can add, which makes them ideal for 
organizing your projects and activities. You can add your own categories to the Master 
Category List if you like. 

Ways to set categories 

Using the Category Picker 

There are several ways to access the category picker. 

•         Click  on the Toolbar. 

•         Right-click and choose Categorize with message(s) selected. 

•         Press Ctrl+T or Alt+Z with message(s) selected. 

•         Click  in the Reading Pane (current message only) 

Using the Reading Pane Categories field 
•         Click into the field Categories - separate each with commas (current message only) 

•         Press Shift+Ctrl+T (current message only) 

Drag to a Category folder 

You can drag one or more messages to a category folder. You can undock the Category view to 
make it more accessible, or you can make popular category folders Hot for easier access 

Assigning categories using NEO Rules 

Incoming messages can be automatically assigned a category based on (part of) the 
subject using a rule. 

To create a new rule, select Rules from the Tools menu. This will open following dialog 
screen. With multiple rules defined, the Rules window can be resized in height or sorting 
can be applied to any column. 
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To create a new category rule or edit an existing one, click “Create new…” or “Edit rule…” 
and click Category: 

 

Rules can be kept in the system without being executed by deselecting the “Rule Active” 
mark.  

“Case sensitive” can be used to limit the rule only to the exact string provided under 
Subject matching the upper/lower case characters. 

Under “Subject” the words to be looked for in the subject are entered. This can be a single 
word, several words or the entire subject. 
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Finally a category needs to be assigned. This is done by clicking ‘Select’ and picking a 
category from the list. 

Click OK when finished or Cancel to exit. 

Assigning categories using the category picker 

With a message selected click Ctrl+T or Alt+Z to open the category picker. The category 
picker lets you choose categories quickly while providing information you need to help you 
keep your categories in good shape. You can choose to work with Master Categories, with 
your Current categories from Category view, or both together. 

Using Categories 
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Editing, removing, deleting, merging, splitting, et c. 

Remove categories from messages 
•         Use the category picker and uncheck the categories (or delete from top area) 

•         Clear the categories from the Categories field in the Reading Pane. 

Remove category from messages and remove category f older 
•         Right-click the Category folder and choose Remove Folder (or press Alt+Del). 

Important :     Do not choose Delete Folder (Del) because this will delete the messages 
themselves in addition to removing the categories from the messages. 

Edit a category 
•         Right-click the Category folder and choose Rename Folder (or press F2). Note that this will 

also rename the categories in all of the messages in which it belongs. 

Create an empty category folder 
•         Right-click the area you want to create the folder in (New, Current, Dormant), and choose 

New Folder (or press Shift+Ctrl+E). 

Combine two categories 
•         Right-click the Category folder and choose Combine Folder. Alternatively, you can drag the 

folder you don’t want and drop it onto the folder you want to keep. 

Split a category folder 
•         Create a new category folder, then drag the messages from the source folder to the new 

one. 

Moving category folders between New, Current and Do rmant 
•         You can manually move category folders by dragging and dropping them on the New, 

Current or Dormant folder respectively. 
 
You can also use the right-click Make Current and Make Dormant commands. 

•         You can automatically move category folders by setting options on the Folder Properties 
(right-click any of the New, Current or Dormant top-level folders). 
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Creating category folder groups 

For added organization, you can choose to organize your category folders into groups.  

To add a group folder, right-click where you want the folder group to appear and choose 
New Folder. Then create the folder: 
  

            

Category Folder List with sample groups defined 
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Attachments 

Overview - Attachments 

If attachments exist for a message, a paperclip will appear in the attachment column of 
the message list pane, and a paperclip will appear on the right side of the message 
reading header. 

Attachment security 

Email attachments can contain programs or other executable objects. If the attachment 
happens to be a computer virus then opening the attachment, either within the message 
or later when you have saved it, can cause serious harm to your computer. Viruses can 
also harm the computers of your correspondents if you spread it by sending them a 
message, or even simply by having them in your address book.  

To help reduce the spread of viruses, security measures are available to you. The 
attachment behavior in NEO mimics the behavior in Microsoft Outlook. 

Important :     NEO does not scan for, identify or protect you from viruses. Only what types of 
attachments are permitted for opening and/or saving is controlled. 

Be sure to exercise caution when dealing with attac hments. 

The type of security available in NEO depends on the security you have installed in 
Outlook. In June 2000, Microsoft made available an optional update called the E-mail 
Security Update. The security update provides for much stricter attachment control than 
previously. 

Microsoft E-mail Security Update installed 

NEO exactly mimics the behavior of the Microsoft update. To modify your settings in NEO, 
consult your Outlook documentation and make the changes in Outlook. NEO will observe 
those settings. 

Microsoft E-mail Security Update NOT installed 

Certain file types may be saved to disk only. Other file types may be opened or saved to 
disk. In NEO, the list of file types that can be saved to disk only is the same as the list 
used in Outlook. However, the NEO list can be modified in the registry. 

Changing the save-to-disk only list 

Note that you should not make changes in the registry unless you are very confident in what you 
are doing. The registry setting to change is: 

NEO Pro:  HKEY_CURRENT_USER\SOFTWARE\CAELO SOFTWARE\NEO 
PRO\4.0\OPTIONS\ALERTEXTENSIONLIST 

Simply add or remove from the list, being sure to preserve the format.  

Alternative for confirmation prompts for a file typ e 

When you save or open certain types of files, you can uncheck a box that says "Always ask 
before opening or saving this type of file."  If you do, it will subsequently automatically open or 
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save the attachment when you click the attachment name from the icon. However, when clicking 
the paperclip icon, NEO now also shows a “Save Attachment” icon below the file name to allow 
the user a choice to save the attachment. 

Re-enabling confirmation prompts for a file type 

When you save or open certain types of files, you can uncheck a box that says "Always ask 
before opening or saving this type of file."  If you do, it will subsequently automatically open or 
save the attachment when you select it. 

You can re-enable prompting again for one or more file types by editing the following registry 
entry: 

NEO Pro:  HKEY_CURRENT_USER\SOFTWARE\CAELO SOFTWARE\NEO PRO\4.0\ 
OPENATTACH 

Simply remove the entry(s) associated with the extension of the file type in question (e.g., 
remove DOC entries to re-enable prompting for Word DOC attachments).  

Opening attachments 

To open an attachment, click on the paperclip at the right of the message reading header. 
It the entry is grayed-out (disabled), attachment security has prevented you from 
accessing it. 

Choose Open it .  

To help prevent computer viruses, certain types of files may not be opened. To open 
these types of attachments, save them to disk and open them there, after you have 
ensured they do not contain viruses.  

Saving attachments 

To save an attachment, click on the paperclip at the right of the message reading header. 

Choose Save to disk. With multiple attachments, the option to Save All Attachments is 
available to save them all at once to disk. 

You may open saved attachments after you have ensured they do not contain viruses.  

Removing attachments 

If you delete a message that contains an attachment, all the objects attached to the 
message are also deleted. 

To remove all attachments but keep the message, click on the paperclip in the reading 
pane and select Delete Attachment(s). 

To remove a single attachment from a message (and keep the message), follow the 
following steps: 

1. Open the message in the message editor (double-click the message or enter Ctrl+O).  

2. Select the attachment(s) you want to remove. 

3. Right-click and choose remove. 

Note that when you remove attachments in this way, they are permanently removed (they 
do not go to the Deleted Items folder). 
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Searching 
  

Searching 

Entering search words and phrases 

Unlike Outlook that searches for word strings, NEO searches for whole words.  

For example, in Outlook, entering "ever" returns messages with "ever", "every" and 
"Everest" in them) whereas in NEO entering "ever" returns messages with "ever" (or 
"Ever") in them.  If you want to get variants of "ever" you would enter "ever*" (so add 
wildcard ’*’). 

Easiest way to start a search 
From anywhere in NEO enter your search word(s) in the Search entry box above the message 
listing: 

 
• Press Enter (or click the left search icon) to search through all message stores 

• Press Shift+Enter (or click the right search icon) to search only through current folder 
(Search in Folder) 

 

Other way to start a search  

• From anywhere in NEO, run a new search by clicking  New Search    on the Home tab of 
the ribbon (or press Ctrl+Shift+F). 

• From within Search view, click Clear (or press Esc).  It's a good idea to get in the habit of 
clicking Clear before each new search because it resets all parameters and puts you in the 
text field. Please note that “Match Similar Words” is a sticky option which is not reset when 
clicking Clear, 

Then simply enter a word or words into the white field at the top of the Search view, then 
click Go (or press Enter). 

In the reading pane, NEO will high-light matching search words. 
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Entering search parameters 

 

 

How to enter words to search 

Search finds all messages containing the words  you provide. A message is selected if 
your provided words are found anywhere in the message subject , message body , or 
address information .  

Search expressions and examples 
• Unless you direct otherwise, if you enter more than one word, messages are found that 

contain all words.  

Ex:    red green blue   (same as entering  red and green and blue) 
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• Whole words are searched for. 

Ex:    handle will find handle but not handlebar 

• Use the wildcard character * to search for words ending in an unknown sequence. 

Ex:    handle* will find handle and handlebar 

• Use quotes to locate exact phrases 

Ex:   "in that case" finds messages where words are exactly as shown.  

• Searches are case-insensitive - it's easier to enter as lower case. 

Ex:    monday will find monday and Monday 

• The words and, or, not and near can be entered, and parenthesis can be entered to control 
order of execution. 

Ex:    (car or bus) near accident  finds messages containing car or bus if either word is within 
ten words of the word accident 

Ex:    car or (auto not bus) finds messages containing car and messages containing auto 
that don’t contain bus.  

• Punctuation is replaced by blanks before the search (except for *).  

Ex:    Standard&Poors is the same as entering Standard Poors.  

About word indexing 

Searches are fast because NEO creates and uses a separate listing (index) of all the 
words in all messages to speed up lookups. 

Word indexing takes place in two places: in the background, or by updating the word 
index manually. 

Automatic background word indexing 

NEO indexes all your messages regularly according to a time frequency in minutes you specify. 
See  Tools menu | Options | General tab to see how to set how often you want background 
indexing to occur.  

Manually updating the word index 

Since your word index may be out of date while between background indexes, you can force an 

update of the word index by clicking Manually Update Word Index    in the Search 

parameters.  

In practice, it's quite rare that you will need to search for messages that you have just received, 
so it's probably not worth forcing a manual update unless you are looking for a very recent 
message. 

Saving Searches 

Normally when you run a search the results appear in the Current Search Results folder, 
replacing the results of your previous run. This is the most common use of search - simply 
searching to quickly locate a message you need once. 

If you have a recurring use for search results, you can save the search parameters and 
results in its own folder.  
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About Search Folders 
• Both the parameters and the results are saved.  

• The results remain the same until you refresh them (they’re static). To refresh the results to 
include recent messages, right-click the folder and choose Refresh Search .  

• When you run a search, the results and parameters you enter always replace the currently 
selected Search Folder . Most often this is Current Search Results, but if it is a differed 
search folder the parameters and results will replace it.  

• Search Folders can be made Hot (right-click and choose Make Hot).  

• You can create Group folders in Search Folders to help organize your folders.  

Working with Search Folders 

Saving a Search 

• Run a search:  click Clear, enter words to search, then click Go.  

• Click the Save Search command  . 

• Optionally, rename the search folder (see next section).  

Renaming a Search Folder 

• Right-click the folder and choose Rename Folder (or press F2).  

• Refreshing a Search Folder 

• If you simply want to update the results, right-click the folder and choose Refresh Folder.  

• If you want to edit the parameters, select the search folder, change the values, run the 
search, then click the Save Search command.  

Refreshing a Search Folder 
• If you simply want to update the results , right-click the folder and choose Refresh Folder. 

• If you want to edit the parameters , select the search folder, change the values, run the 
search, then click the Save Search command. 

Removing versus Deleting a Search Folder 
• Remove  a search folder when you want to remove the folder but leave  all the messages in 

the folder. Right-click the folder and choose Remove Folder (or press Alt+Del). 

• Delete  a search folder when you want to remove the folder and delete  all the messages in 
the folder.  Right-click the folder and choose Delete Folder (or press Del). 

Searching in a Folder 

You can Search within a Folder  in following ways: 

1. Enter search word(s) in the search entry box above the message listing and press 
Shift+Enter (or click the right search icon) 

2. Click the Search in Folder icon on the Home tab of the ribbon to search in currently 
selected folder: 

 

3. Right-click any NEO or Outlook folder and choose Search in Folder: 
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4. Choose the Search view Folder menu. When you click any of the views listed you 
will be able to choose a folder within it.  

       

Excluding Excluded and Deleted Items in Search 

In Search view you can choose to search All Folders, any selected folder or choose to 
search All Folders except Excluded and Deleted Items.  

           

The choice you make remains in effect until you change it. To clear your search 
parameters, click Clear . 

Why saved searches are useful 

Suppose you are responsible for bicycle safety standards at the Ballistic Bicycle Helmet 
Company. Everyone in your company is instructed to forward messages to you 
concerning safety.  You always want to have easy access to your safety messages. 

You could create a search with words to search:  safe* or standard .  If you saved that 
search result, as Safety, you could rerun the search whenever you wanted by clicking 
Refresh Search (right-click the Search Folder). Your search results would then be updated 
to include all new messages since the last time you ran the search. 

You could even make the Search folder Hot so that it is readily visible in your Hot view, 
and where you could easily see your unread safety messages.  

Saved searches lend themselves to organizing groups messages on an ongoing basis 
where it is easy to identify a message. Message conventions that include consistent 
references such as a project or docket number are ideal candidates. 
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Search on Conversation 

To quickly see all related messages: 

• Switch to Conversation View by clicking the Conversation View icon on the Quick Access 

Toolbar:  

• Click   on the Home tab of the ribbon, or 

• Press Ctrl+Alt+F. 

You will then be quickly positioned in Search view with all messages based on the same 
'conversation' displayed. 

  

When done, click    or press Alt+LeftArrow  to go back to the folder your came from. 

About 'Conversation' 

Every message has a property called Conversation, and it is usually the same as the 
Subject property but it can be different. 

When a new message is created, the current Subject is copied to the message's 
Conversation. However, if the Subject is edited (Ctrl+B), the two will be different. 
Conversation always remains as the original Subject. 
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Junk Mail - Spam 

Junk Mail and its challenges 

What is junk mail  (also known as SPAM) 

Loosely speaking, junk mail is any email that you didn't directly request. In email 
terminology, it's called unsolicited commercial email (UCE).  

Sometimes junk mail is useful - mostly it is unwelcome. 

What's not junk mail 

Email that you give permission to others to send to you is not junk mail because  you have 
opted in to receiving it. You'll continue to get it until you unsubscribe. 

Likewise, if you subscribe to announcements from companies or have joined mailing lists, 
this also is not considered junk mail. 

The challenges of Junk Mail 

Junk emailers use many techniques to trick you into reading their mail.  

One common technique is to use a different sending email address for every email they 
send to you. This makes using blocking lists based on addresses a relatively futile 
exercise, but sometimes it does work to block email addresses. 

Some email programs use filters and rules based on words to identify junk mail. This is 
more successful than address-based exclusions but run a high risk of excluding 
messages that are not junk (false positives). 

Strategies for dealing with Junk Mail 

NEO's approach 

Rather than take explicit action for each piece of junk mail, we believe it's better in the 
long run to take action on the mail you want to keep.  

NEO's ability to automatically separate Bulk Mail from Correspondent mail is the first 
important step. However, you still need to deal with the remainder of your junk mail. 

Directing Junk Mail to an Outlook folder 

You can tell NEO to ignore spam folders so email in them is excluded from NEO's normal 
organization folders (e.g., Active Mail, Today, etc.).  These can be folder(s) you direct mail 
to manually, or can be folders used by a spam-detection program. 

If you get lots of junk mail, we recommended that you use a third-party spam-detection 
program (or the one included in Outlook 2003 or above). Even with a spam-detection 
program, some junk mail will still find its way into NEO. 
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Using NEO to clear out your junk mail 
1. Create bulk mail folders for all of your non-junk email (mailing lists, ezines, announcements). 

When you do this, all bulk mail that would normally be put into the Unsorted Bulk Mail folder is 
instead redirected to its appropriate Bulk Mail folder. 

2. When you see junk mail, you need to decide whether to delete  the message or block the 
sender . Most often, junk senders use completely different addresses each time they send 
junk mail to you. In this case, just delete the message. Sometimes, however, they use the 
same address or a variation of it. In that case, you can block the sender. 

3. Check for junk mail often to keep it from piling up. New junk mail will arrive in two locations in 
NEO:  

a)   Unsorted Bulk Mail  folder in Bulk Mail view .  Browse this folder daily and delete 
messages or block senders. These should be easy to find since these unsorted messages 
are mostly junk (although it may contain new non-junk messages you may have 
subscribed to but have not yet organized - see step 1). 

b)   New top-level folder in Correspondent view .  Here you will see all correspondents who 
have sent you new messages for the first time. Check this daily. For junk mail, delete 
messages or block senders. For New Correspondents you want to keep, right-click the 
Correspondent folder and choose Make Current.  
 
If you process your New folders each day, it's easy to stay on top of it. 

4. Empty your Junk Senders folder frequently. 

  

Excluding Spam Folders from NEO 

Many people use programs to automatically detect and isolate spam (junk mail) into one 
or more Outlook folders. Later versions of Outlook have this feature built in, and many 
third party programs have more extensive capabilities. 

NEO supports these programs by allowing you to exclude from NEO messages going into 
these spam folders. The excluded messages are still viewable in your Outlook folders (via 
NEO's Outlook view) - they just aren't included in any of NEO's normal folders such as 
Active Mail, Today, and so on. 

How to exclude folders from NEO 

You can exclude any Outlook user folder that you define. In fact, it isn't restricted to spam 
folders. You may want to choose to exclude other user-defined folders too. 

•         Right-click the folder in NEO Outlook view and choose Folder properties,  

•         Check the "Folder contains Spam" checkbox 

How it works 
•         When a message is moved into your designated spam folder, the message is excluded from 

NEO. If it is moved out of your spam folder, it becomes included in NEO.  

•         This happens whether your program automatically handles the message or you handle it 
manually.  

•         Excluding starts from the time in which you add the folder to the list in NEO, and stops when 
you remove it.  Therefore it may be that your designated folder has some messages that are 
excluded and some that are included.  We recommend that you empty the spam folder 
before adding it to the NEO list.  
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Using third-party spam detection programs 

In some cases, for third-party spam detection programs to work with NEO, you must do 
the following: 

•         be sure to start Outlook before starting NEO, AND 

•         keep Outlook running until you turn off your computer.  

If the spam folders are not being excluded as expected, please follow the above, or 
connect to our knowledge base available on our support page. 

Blocking Spam senders 

We normally recommend that you simply delete junk email because most junk mail 
senders use completely different email addresses each time. However, If you get multiple 
junk mail messages from the same email address, or using the same email address or 
email name pattern, you can block the sender. 

How blocking a Spam Sender works 

When you block a sender, all email from that party will appear in no NEO folders except in 
a special, restricted folder called Spam Senders in the Spam top-level folder of Bulk Mail 
view. 

The effect of blocking a sender is that the address (or address pattern) is added to the list 
of addresses for the Spam Senders folder. You can review the messages contained in the 
folder, and you can empty the folder like you can with Deleted Items. 

When clicking the “Block Spam Sender” icon on the toolbar, the action requires 
confirmation to avoid unintentional blocking of senders. 

The Spam Senders list 

Quickly blocking a Spam Sender 

Highlight one or more messages and … 

o   click Block Spam Sender  on the Standard toolbar, or 

o   press Ctrl+Shift+X, or 

o   right-click and choose Block Spam Sender, or 

o   drag and drop them onto the Spam Senders folder. 

This will add the sender's email address to the Spam Senders folder. 

Manually adding to or editing the Spam Senders list  

To edit the Spam Senders list, double-click  the Spam Senders folder (in Bulk Mail view), or 
right-click it and choose Folder Properties. Then like any Correspondent or Bulk Mail folder, you 
can manually change, add, move or remove addresses.  

To remove someone from the list, use the Move command. You can also add address patterns 
to capture senders who use variations of the same sending address. 

Deleting Spam Sender messages 

Messages whose senders you have blocked are visible only in the Spam Senders folder. 
You may want to browse it before deleting its contents. 
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If you delete the messages from the list pane , they will be sent to the Deleted Items 
folder (unless you use Shift+Del for permanent deletion).  If you empty the folder (right-
click the folder and choose Empty Folder) the messages are permanently deleted. 

In either case, the list of addresses remains after you delete the messages. We 
recommend that you empty the folder frequently. 
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Synchronizing 
with Outlook 

About Synchronizing with Outlook 

NEO normally displays all the messages in your message store(s). However, NEO doesn't 
know about new, changed or deleted messages that are processed when NEO is not 
running. 

How it works ... in a nutshell 

If NEO is running when new messages arrive, are changed or deleted, then you'll always 
see all your messages in NEO (NEO keeps you synchronized on-the-fly).  

If NEO is not running, then NEO will not know about these message events and will need 
to get synchronized again by you syncing manually (e.g., when you next start NEO).  

How to stay synchronized 

It helps to understand synchronization because it can affect what messages you see in 
NEO.  

Quick way to stay synchronized - Recommended! 

We recommend all users enable the option Fast synchronize on startup. It syncs quickly 
and runs in the background so that it won't get in the way of getting going with NEO. 

Fast sync (on startup) will ensure you are updated with new and changed messages. 
You'll also stay up to date with messages you delete when NEO is running. 

Full sync will be needed when you delete messages (e.g., in Outlook) when NEO is not 
running. You'll know this because you'll see a message in NEO that is listed but whose 
contents can't be displayed. 

In summary,... if you Fast Sync on startup and you never delete messages in Outlook, 
you'll always stay in sync.  Try to remember to always delete your messages in NEO 
instead of Outlook. 

More about synchronization 

Not required reading, but for those who want to fine-tune their synchronization actions a 
little more, here is additional information. 

If NOT using Exchange Server (i.e., PSTs only) 

If you NEVER run Outlook without NEO running then you'll always stay in sync even 
without using the Fast sync on startup option. That's because Outlook will never read your 
messages without NEO being aware of it. 

If you regularly use Outlook in addition to NEO, you can set an option to start NEO 
automatically whenever Outlook starts. You can, of course, send and receive mail without 
Outlook running – but if you do open Outlook, ensure you open NEO first. 
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Be aware that If you are choosing not to sync on startup you might sometime accidentally 
run Outlook without NEO, and you will get out of sync and must then do a fast or full sync 
manually. 

Exchange Server users 

You will remain synchronized if you always have NEO running when LAN connected. 
However, if you turn your computer off, or you are just reconnecting to the network, you 
must synchronize when you start. 

We strongly recommended that Exchange Server users enable the Fast sync on startup 
option because they will start getting out of sync as soon as they disconnect from 
Exchange Server (e.g., turn of their computer). This occurs whether Outlook is running or 
not. 

Note :    NEO Synchronization is different than the synchronization between your Exchange 
Server mailbox and your offline message store (OST). 

Choosing message stores to keep synchronized 

Click Synchronize  on the Home tab of the ribbon to control how you want to synchronize 
(Fast sync or Full sync), and to choose what message stores you want to synchronize. 

The messages stores checked the top of the dialog are the ones that are synchronized 
when you perform a Full or Fast sync. You may want to consider not synchronizing older 
messages stores that you only use for reference purposes. 

Messages for message stores you choose not the synchronize will still remain in your 
catalog - they just won't be updated if the messages are edited or deleted, or new 
messages are put into them. 
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When running synchronize as foreground task, a status dialog will inform you about the 
synchronization progress. You may safely cancel it at any time. 

When to synchronize manually 

NEO keeps you in sync "on-the-fly" if you always run NEO when messages are being 
processed.  

However there are times when you may need to synchronize manually, and it's different 
depending on whether you are an Exchange Server user or not.  

Exchange Server User ? 
•         Each time you start NEO you will need to do a Fast Sync.  

•         If you deleted messages in Outlook when NEO was not running, you will need to perform a 
Full Sync.  

Not using Exchange Server ? 
•         If you had Outlook open without NEO but did not delete any messages, you need to do a 

Fast Sync. Click on the Fast Sync command on the toolbar.  

•         If you had Outlook open without NEO and you deleted messages in Outlook, you will need 
to perform a Full Sync.  

How to synchronize manually 

Click one of the synchronize buttons on the Quick Access Toolbar: 

 
Or make your choice from the Synchronize  pull-down menu on the Home tab: 
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Catalogs 

Catalog Overview 

NEO works by creating indexes to your messages and storing them in a separate 
database called the catalog. Your messages are not stored in the catalog, just references 
to them. 

Whenever messages are sent, received or updated in a message store, NEO 
automatically updates the indexes in the catalog. 

Your first catalog 

A catalog is created when you start NEO for the first time, and whenever NEO is opened 
with a new mail profile. The catalog is created using a Catalog Setup wizard in several 
steps. The more messages you have the longer it will take to create your catalog, 
however catalog creation is only performed once. 

Normally you would include all your message stores in the catalog. Also IMAP message 
stores can be added. 

Multiple catalogs 

You can have more than one catalog. Also you can open multiple copies of NEO Pro 
using different catalogs.  

All messages from all messages stores in a catalog are unified - that is, organized 
together in the same Correspondent folder, as results of searches, and so on. If you want 
to keep message stores separate then create separate catalogs for them.  

A few reasons to have more than one catalog:  

• You want messages from some message stores to be organized in their own space (e.g., 
messages from previous employment or a different email account). 

• You are a delegated user for another person's Mailbox in Exchange Server. NEO Pro 
requires that you only include a delegated Mailbox if it is the only Mailbox in the catalog. 
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Catalog Basics 

Open a catalog 

When starting NEO it will by default open the most recently used catalog. 

You can manually open a catalog in following ways 
1. Pick from the most recent used list after clicking the Application Button. 

 
2. Click the Application Button, select the Catalog menu… 
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and click Open Catalog: 

     

When the dialog opens you see the catalogs you have created for your current mail 
profile. You can choose to open up a catalog from another profile by selecting the option 
at the top. 

3. Use a command line option to open a specific catalog. See section Ways to Start NEO in 
Getting Started. 

Automatic catalog opening 

By default, the last catalog you opened is automatically opened for you next time you start 
NEO. If you don't want automatic opening to occur, you can: 

1. Disable the option. See Tools menu | Options General tab. 

2. Override the automatic open option by pressing the Shift key when clicking your NEO Pro 
desktop shortcut (keep Shift down until NEO is fully open). 

3. Use a command line option to open a specific catalog 

Closing a catalog 

You can: 
1. Choose Close Catalog from the Catalog menu on the Application Button. 

2. Open a different catalog. 

Your Message Stores  

Message stores defined 

Message stores are repositories of messages and Outlook items. In Outlook, they are in 
your Folder List and look like this (in collapsed mode): 
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In NEO these same message stores appear in the NEO's Outlook view. There are five 
message stores types that NEO Pro organizes: 

Exchange 
Mailbox  

If you use Exchange Server, this is typically where your 
messages are delivered. This message store is your Mailbox 
which is where your email data is stored on your company's 
server computer. 

Exchange 
Delegate 
Mailbox  

You can delegate access of your Exchange Mailbox to others. 
When you do, it appears in their Folder List just as though it is 
theirs. This message store is located on your company's 
server.  

Personal 
Folder 
(PST) 

Sometimes known as PSTs, Personal Folders, or Data Files, 
these are typically stored on your own computer. You create 
these in Outlook to improve Outlook performance. 

Offline 
Folder 
(OST) 

These are special Exchange user variants of Exchange 
Mailboxes that contain messages you have designated to 
synchronize for offline use. These are automatically handled 
by NEO when you are in offline mode. Cached Exchange 
Mode in Outlook 2003 makes extensive use of Offline Folder 
files. 

IMAP 
folders  

When adding an IMAP email account (such as Gmail) to your 
Outlook system, you will find the online IMAP folders in your 
Outlook Folder list. These can be organized in your NEO 
catalog. 

Moving or closing your Outlook message store (Perso nal Folder, PST) 

If you move an Outlook message store that is organized in NEO, Outlook changes its 
internal identifier. When you next start NEO, NEO will then not be able to find it. To make 
it visible within NEO again you will need to remove it and re-add it (see next section).  

If you close an Outlook message store in Outlook you will need to remove it from NEO too 
(again, see next section).  

Adding and removing message stores 

You can only add message stores that are in your current mail profile.  

Note :    If you change the message stores that are in your Outlook profile, you must 
restart NEO (the message stores available to NEO are only determined when 
NEO starts). 
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You explicitly add or remove messages stores via Catalog Properties by clicking Message 
Stores on the Application Button menu, or when you create a catalog. 

Here is the how you choose catalogs when creating a catalog: 

           

Check the message stores you want included, and uncheck those not to include in NEO. 
You can add or remove message stores from your catalog at any time. 

You don't need to add/remove offline message stores explicitly. When you go offline in 
Outlook, with or without Cached Exchange Mode, NEO will automatically organize your 
offline store. 

You can choose from message stores in your mail profile. If you want to include message 
stores not in your profile, you must add them to your profile first. 

Set a time limit for older messages in the Catalog 

You can keep older messages out of NEO’s catalog by setting a time limit by going to the 
Miscellaneous tab under Tools | Options.  

           

Messages older than the selected date will be excluded from NEO’s catalog independent 
how or where they are organized within the Outlook system. 

Changing this date will force a full synchronization and update of the word index. 

Catalog Properties 

Use Catalog Properties to review information about a catalog, and to add/remove 
message stores from a catalog. 
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General tab 
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Messages Stores tab 
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You will only be able to choose more than one message store. Message stores that are 
delegated into another Exchange Server's Mailbox must be alone in their own catalog. 
When including an IMAP message store two additional tabs are available to identify IMAP 
specific folders. 
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When including an IMAP message store is it necessary to indicate the IMAP folder 
containing Sent Mail. 

 

 

For the IMAP message store it is possible to exclude the All Mail folder to avoid duplicate 
emails within NEO (depending on the on-line IMAP folder organization). When selected, 
these emails will be completely excluded from NEO. To make them visible again within 
NEO, deselect this folder. 

Creating and Deleting Catalogs 

Creating a New Catalog 

You can create as many catalogs as you like. 

You create catalogs using the New Catalog wizard. Click File menu | Catalogs | New 
Catalog to start it. The New Catalog wizard also starts automatically the first time you run 
NEO, or when you open a mail profile that you haven't yet created a catalog for. 

The New Catalog wizard consists of seven easy steps. You can cancel or go back and 
edit your settings at any time - catalog creation doesn't start until the final step. 
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Step 1  
Choose a 
name 

 

 

 

Best to enter something descriptive 
that describes what's in the catalog 
(e.g., Pre2000 Messages). The name 
must be unique across all your 
catalogs. 

 

Step 2  
Choose 
location for 
catalog and its 
backup 

The default location for your catalog is 
the same general area of your 
Application Data into which your 
Outlook personal folders are stored. 
You can put it wherever you like 
where there is enough disk space 
available. 

Default backup location is <catalog 
location>\Backup. 

You can choose a network drive or 
even a memory drive (as long as the 
memory drive saves and restores its 
content upon system 
shutdown/restart). When you place 
your catalog on a memory drive, make 
sure to place the backup on a different 
location. It's faster to store it on your 
local computer where a memory drive 
will be fastest. 

Note that by default, like Outlook, the 
catalog is stored in the non-roaming 
(user specific) section of your 
computer. 

 

Step 3  
Catalog 
settings 

• You can import your settings from a 
previous catalog of any version 
(e.g., v2, v3, v4, v5). 

• You can define whether searches 
take punctuation and special 
characters into account or not 
(default is to ignore punctuation and 
special characters). 

• Also here, you can enable the 
automatic Bulk Mail assignment for 
indirect messages. See below for 
further explanation. 

 

Step 4  
Select your 
message 
stores 

Normally you would select all 
message stores for a seamless 
organization of all your messages. 

Note: when including an IMAP 
message store, two additional wizard 
screens will appear after step 5: step 
5a and 5b. 
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Step 5  
Identify your 
spam folders 

Identify if you have folders that 
capture Spam (junk mail). Microsoft 
Outlook and many spam-detection 
programs automatically funnel spam-
looking messages to Outlook folders. 

Messages contained in the spam 
folders you designate are not included 
in NEO. You can change this at any 
time within NEO. 

 

Step 5a  
IMAP: identify 
sent items 
folder 

Select the IMAP folder containing Sent 
Items. 

Step 5a will only show when including 
an IMAP message store in step 4. 

 

Step 5b  
IMAP: exclude 
the “All Mail” 
folder from 
NEO 

Optional the IMAP folder containing 
“All Items” can be excluded from NEO 
to avoid duplicates – this is depending 
on how the on-line IMAP folders are 
organized. 

You can change this at any time within 
NEO. 

Step 5b will only show when including 
an IMAP message store in step 4. 

 

Step 6  
Verify your 
email 
addresses 

NEO needs to know which email 
addresses are yours. Note that NEO 
needs to know all your addresses - 
even ones you don't use any more.  

NEO attempts to determine your 
addresses automatically. Add to or 
remove from this list. 

 

Step 7  
Start 
synchronization 

Now that all the information is 
collected, click Next to start the 
synchronization process. A progress 
dialog will appear. 

It's an ideal time to take our NEO 
Tutorials. To do so, leave the 
checkbox checked. 
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Catalog Settings 

 
In here three settings determining Catalog configuration can be chosen: 

1. Import settings from a previous catalog 

2. Enable punctuation and special characters in searches (default: ignore 
punctuation) 

3. Enabling the automatic Bulk Mail assignment for indirect messages (default: 
disable automatic bulk mail assignment) 

Importing previous Catalog settings 

If you are upgrading from a previous version of NEO, or you want to create a new catalog 
similar to an existing one, you can carry-forward the settings into your new catalog. 

The settings imported depend on the version of the catalog you are importing: 
NEO 2 Your Search folders are not carried forward. Neither are the settings that 

determines which folders are Hot (except that Correspondent and Bulk 
Mail folder Hot setting is carried forward). 

NEO Pro 3 / 4 All setting are carried forward. 

The settings are imported  into the new catalog. The catalog the settings are imported 
from is unaffected. 

Choose the Catalog version then either select from the list or browse to the catalog 
location (highlight the file named CatalogConfig.xml). 
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Enabling punctuation and special characters during searches 

Default behavior of searches within NEO is to ignore punctuation and special characters 
during searches. With this option users can define to make searches sensitive to 
punctuation and special characters. Also when NEO rules need to be sensitive to special 
characters in the subject line, this option needs to be enabled. Once a catalog has been 
created this option can always be changed by rebuilding the catalog from the File | 
Catalog | Rebuild Catalog menu. 

Enabling automatic Bulk Mail assignment for indirec t messages 

By default NEO Pro is classifying all messages into your Correspondent Folders. As such 
the Unsorted Bulk Mail folder on the Bulk Mail tab will be empty. 

However, if you like NEO to automatically classify all messages addressed indirectly to 
you (like e-zines, newsletters, and so on) as Bulk Mail you can enable this here. If 
selected, NEO will organize all these messages during catalog creation under the 
Unsorted Bulk Mail folder on the Bulk Mail tab. From here you can (and should) re-
organize them into their own Bulk Mail folder or re-classify them as Correspondent. 

This catalog setting can be verified for the open catalog by clicking the Application Button 
and selecting Catalog | Catalog Properties. 

After creating the catalog, this setting can be changed during a Catalog Rebuild (see 
below). 

Deleting a Catalog 

When you delete a catalog only the NEO information is deleted. Your messages will 
remain. 

1. Click Application Button | Catalog | Delete Catalog. 

2. Choose catalog to delete. You can select a catalog from your current profile or all profiles. If 
you do not see your catalog in any profiles, click Browse to locate it. 
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Catalog Maintenance 

Rebuilding a Catalog 

Sometimes it's necessary to rebuild your catalog, for example when one of your database 
records gets corrupted after a power failure. Note that you should always shut NEO down 
normally to help prevent errors such as these. You can rebuild by clicking the Application 
Button and selecting Catalog | Catalog Rebuild. 

It is normally not necessary to rebuild your catalog to improve performance. You should 
only need to do it when advised to.  

The rebuild process completely rebuilds your catalog from your messages. All your folder 
names and settings will be preserved unless you specify differently. Rebuilding your 
catalog can take almost as long as it took to create your catalog in the first place.  

You can choose to build the current catalog or choose another catalog. 

You can also choose to change the Catalog Setting for Search Option and Automatic Bulk 
Mail Assignment. To change setting for Bulk Mail assignment, first select Reset NEO 
Folders (NOTE: this will reset all changes you have made to your NEO folders like 
combining Correspondents or defined Bulk Mail folde rs; also, this will reset and 
remove all defined NEO Rules ). Alternatively, you can create a new catalog to disable or 
enable the Automatic Bulk Mail Folder assignment. When rebuilding without changing this 
setting, the original defined setting is used during the rebuild. 
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Rebuilding Conversation Index 

Sometimes the Conversation Index need to be rebuild (e.g. when conversations are not 
properly grouped together anymore). This can be done by clicking Application Button | 
Catalog | Rebuild Conversation Index and click OK. 

 

Restoring a Catalog from Backup 

You can use the Restore from Backup feature to overcome a data problem with your 
catalog.  

As a safety precaution, NEO backs up critical catalog files to a folder called Backup in 
your catalog folder or as defined during catalog creation. The Restore from Backup 
feature uses these critical files to completely rebuild your catalog from the saved files. You 
can find current backup location by going to Application Button | Catalog | Catalog 
Properties. 

To restore your data: 



P a g e  | 143 

1. Click Application Button | Catalog | Restore from Backup. 

2. Choose catalog to restore.  

       

Backing up and restoring the catalog 

The catalog contains information you have entered about your messages such as 
Correspondent and Bulk Mail properties, your Hot folders and so on. Even though you 
could always recreate your catalog from scratch if it got corrupted, you would lose some of 
the configurations you have made. 

NEO automatically backs up key data files 

At least every three days NEO backs up key data files to the backup location specified 
during catalog creation (default backup folder is <catalog location>\Backup). You can 
define a new backup location on the Application Button | Catalog | Catalog Properties 
screen where also current backup location is shown. From these key files, your catalog 
can be completely rebuilt without any information loss. 

You can use Restore from Backup (Application Button | Catalog | Restore Catalog menu) 
to restore and rebuild your catalog. It will automatically use these previously saved files. 

Backing up the catalog manually 

While the above offers some protection in restoring to correct data corruptions, it offers no 
protection against accidental deletions, hardware failures, and the like. 

You may wish to back up the catalog manually to an external location. You can choose to 
simply back up the key data files from your catalog (or backup) folder(s), or you can 
choose to back up all the files from your catalog folders. If you choose just the key data 
files you will need to also then perform a catalog rebuild operation after restored, whereas 
if you back up all the files in your catalog a catalog rebuild is not necessary. 

There are four key data files to back up. The current versions exist in your catalog folder, 
and older backup versions exist in the backup folder. The files are: 
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• CatalogConfig.xml 

• NAD.dat 

• NFL.dat 

• NSB.dat 

Restoring the catalog from a manual backup 
1. Close NEO. 

2. Restore the files you backed up to your NEO catalog location. 

3. If you restored just the four key data files, you must also do a catalog rebuild.  

Locating and moving the catalog 

Where the catalog is stored 

The catalog is stored in a folder of your choosing. To find where the current catalog is 
stored, view the catalog properties. Click Application Button | Catalog | Catalog Properties. 

A quick way to locate where your default catalog location is to start creating a new catalog 
(click Application Button | Catalog | New Catalog) then click through the first panel and 
you will see the default location. You can also browse from there. You can click Cancel to 
stop the New Catalog wizard. 

To find all your catalogs on your computer, you could also do a Windows Search and 
search for all occurrences of file CatalogConfig.xml .  

Moving the catalog 

There is no command within NEO to move the catalog. However, if you wish to move it 
you can do so using these steps: 

1. Close NEO. 

2. Locate the catalog you want to move (see above). 

3. Move the entire catalog folder and subfolders to your new location (it must not exist in the 
original location – if you copy it, delete it from the original location). 

4. Start NEO. You will be notified that the catalog files are missing.  

5. Click Application Button | Catalogs | Open Catalog. Select the catalog you want to open in the 
list then click Browse. Browse to your new location and select the file CatalogConfig.xml.  

  



P a g e  | 145 

Printing 

Printing messages 

Printing message contents 

Highlight one or more messages. Do one  of the following:  

•         Click the Printer icon on the toolbar 

•         Press Ctrl+P 

•         Click Print on the Application Button menu 

•         Click Print on the shortcut menu 

Printing to a printer other than the default printe r 

When printing from the NEO List Pane, the output always goes to the default printer that 
you set in Outlook.  

To print to another printer, open the message, click print then you can change the printer.  

Print Setup options 

Print Setup options such as the printer you want to print with, page orientation, etc. are 
permanently  set from Outlook. To change any Print Setup options, switch to Outlook  and 
set the options there. 

You can temporarily  change the Print Setup options for the currently selected 
message(s) by opening the message and selecting Print from the File menu. 
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Buying, Registering, 
Updating, Uninstalling 

How to buy NEO 

All information about purchasing and upgrading NEO Pro is contained in our online store. 

http://www.emailorganizer.com/store/index.php 

  

How to register your license 

Your license 

Registering your license simply means entering your License Code and License Key into 
NEO so that we can enable your product for permanent use. We don't collect any 
personal information other than the code and key (unless you provide it to us in our opt-in 
form).  

To use any NEO product you must have a license.  

When you first start NEO Pro we automatically issue an Evaluation License to you that is 
valid for the evaluation period. When the evaluation period is over you won't be able to 
continue to use NEO Pro until you receive a permanent License.  

When you purchase NEO Pro you will be sent an email containing your License Code and 
a License Key. These two components work together. If you change any part of either 
one, you won’t be registered. 

Entering your license information 
1. Click License  on the Help tab.  

2. Enter your License Code  and License Key  exactly as provided to you, including upper and 
lower case. You may find it easiest to copy and paste it from the email we sent you. 

3. Click Activate .  If invalid, check the email message you received it on and try it again. 

Important: NEO licenses are valid for minor version upgrades (4.0 to 4.1) only. For a major 
version upgrade (from 4.x to 5.x) the license can be upgraded. Click "Get Evaluation License" to 
try a new major version free during the evaluation period. 

4. Click OK. 

Please Note: Individual licenses can only be activated on a single system. Site Licenses can be 
activated for the number of computers the license was issued for (e.g. a site license with 100 
seats can be activated on 100 systems). 

Transferring your license to another computer 
Before you can use your license on another computer, the license first needs to be deactivated on 
the initial system. 
Older product versions may not have a Deactivate function in which case this step can be skipped 

1. On the original system click License  on the Help tab.  
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2. Note down your license code and key to transfer to your other system. Click Deactivate  - 
your NEO product will now close. 

3. On the other system, repeat the initial steps of entering license information as outlined 
above. 

Failing to deactivate the license as described here may invalidate the license. Members of our 
Premium Support program can have their license manually deactivated by sending an email to 
customercare@caelo.com (do provide your Premium Support license information for quick reply). 
More information and how to join our Premium Support program can be found on the support page 
of our website.  

Reinstalling NEO on an existing system 
The license activation process links the license to a unique, encrypted hardware hash of the 
system in use. Reloading the entire software is not affecting license activation when NEO Pro is 
reinstalled. Also the activation process is designed to handle routine hardware upgrades on the 
same system. 

Checking for product updates 

NEO will automatically check for product updates when you start NEO if you have the 
option checked to check for product updates on startup. 

To manually check whether an updated version of NEO is available: 
1. Click the Help  tab. 

2. Click Check for Updates  (online). 

This operation compares your version with the latest version available by connecting to 
our website. You will be told whether or not a new version is available. 

Determining Your NEO Version 

To determine your NEO version: 
1. Click the Help  tab. 

2. Clicking About NEO Pro. 

Uninstalling NEO 

To uninstall NEO: 

1. Click Start, then Control Panel then Add/Remove Programs program. 

2. Select NEO Pro. 

3. Click either Change or Remove (depends on your system). If you clicked Change, 
the choose Remove when the dialog appears. 

REMEMBER: When you intend to use your license on another machine, please FIRST 
deactivate your license from Help | License BEFORE uninstalling.  

4. You can choose whether or not to remove your catalog data. If you believe you will 
not be using NEO again, then choose to remove it. 

5. Also, it helps us to know why you are uninstalling NEO. We'd appreciate it to click 
the box to give us a reason if prompted . 
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Common Questions 
  

If you don't find the answer to your question here, please click Support (online) on the 
Help menu. For downloading, installing or licensing questions, see next section. 

Using NEO 
Can I continue to use Outlook? 

Yes, NEO is meant to work with Outlook and does not stop you from using any of 
Outlook's features, or from using Outlook without NEO. However, when using NEO, we 
recommend that you always start Outlook first. You can easily move into and out of 
Outlook, and your Outlook messages are always up to date and safe. 

What's the best way to start NEO? 

Enable the option to automatically start NEO when Outlook starts, and start Outlook in 
your normal way. 

Does NEO store copies of Outlook messages? 

No. NEO stores indexes (shortcuts) to your Outlook messages. However, if you create 
a message in NEO the message will appear in your Outlook message folder. Similarly if 
you delete a message in NEO it will be deleted in Outlook. You can also move 
messages between Outlook folders from within NEO and the move takes place within 
Outlook.  

Where are my Outlook folders? 

You can still use your Outlook folders and your Outlook rules. Your Outlook folders are 
accessible from NEO through the Outlook view. You can even make an Outlook folders 
hot. 

Does NEO work with all parts of Outlook? 

NEO focuses on email, but does provide quick access to your Calendar, Tasks, and so 
on. There are, however, some parts of Outlook that NEO does not integrate with: 

1. Public Folders (in Exchange). 

Does NEO work with IMAP message stores included in Outlook? 

Yes, NEO Pro can also organize all messages included in the IMAP message store as 
visible in Outlook. 

What is Active Mail? 

Active Mail gives you more control in managing your incoming email. 

When I move a message it doesn’t appear to move! 

Messages in NEO appear in more than one place at the same time, and the folders are 
created automatically for you based on the characteristics of your message alone. You 
can’t drag messages to most NEO folders. 
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However, if you move a message from say, Today, to an Outlook folder, the message is 
moved from your Outlook folder (probably Inbox) to the folder you specify. However, it 
still appears in the Today folder because it is still a message you received today. 
Likewise, for Correspondent and most other NEO folders. 

How do I make folders hot? 

Right-click the folder you want to make hot, and click Make Hot. If it is already hot, 
clicking Hot will make it un-Hot. You can make any folder in NEO hot, including Outlook 
folders. 

How do I exclude Spam folder messages from showing in NEO? 

You can designate folders that are to be excluded from NEO's organizational folders 
like Correspondent folders. You choose your spam folders when you create a catalog, 
but you can also specify that setting as a Folder Property for any Outlook user-defined 
folder (right-click the folder and choose Folder Properties). 

How do I create a Group folder? 

Right-click in a view's Folder List and choose New Folder. When the dialog appears, if 
there is a Folder type choice at the top, choose 'Group folder'. 

Note that you can create Group folders in any NEO view except Hot and Outlook. Also, 
you must be in Folder List Tree sort order.  

Search didn't find a message it should have 

The most likely reason is that it was a very recent message. Like the web, NEO makes 
searches fast by indexing words in the messages. However, it only does this at certain 
times - the default is every 60 minutes. You can change how often NEO does a word 
index. 

How do I exclude Deleted Items and Excluded folders  from my search? 

See Excluding Excluded and Deleted Items when searching. 

How do I hide Sent mail from NEO folders? 

Except for Active Mail, all NEO folders automatically display both sent and received 
mail. You can use the Direction filters on the Filter toolbar to show Sent, Received or 
both types of mail. 

How do I add a message store? 

You can organize more than one message store in your catalog. To add another 
message store (or change what message stores are included in your current catalog), 
click Application Button| Message Stores. Note that a message store must be in your 
current profile (i.e., visible in your Outlook Folder List) to be able to add it to your 
catalog. Also, note that you must restart NEO after adding new messages stores in 
Outlook so that NEO can see them. 

How do I copy a message? 

Right-click-drag the message or messages from the List Pane to the folder you want to 
copy it/them to. When you release the mouse button, you will be given the choice to 
copy or move. 

How do I stop connecting to the Internet in the Rea ding Pane? 

Like Outlook, when an HTML message in the Reading Pane needs an object from the 
Internet, it automatically goes and gets it (subject to your Connection tab option settings 
in Internet Explorer). 
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You can completely prevent NEO from getting those images (whether you are 
connected or not, and regardless of other settings) by setting an option. 

What Outlook folder is my message in? 

Look on the Reading Pane header. The Outlook folder a message is stored in is 
labeled Folder. It can be Inbox, Sent Items, Drafts or any user-defined folder. 

To see all the locations in NEO where a message is stored, look at the message 
properties. Right-click the message in the message list pane and choose Message 
Properties. 

Where are my Personal Folders (PSTs)? 

NEO Pro can work with all your message stores (PSTs). You can add more message 
stores via Application Button | Catalogs | Message Stores. 

Why are there Read messages in the Unread folder? 

During our usability testing, we found it disconcerting for a message to disappear the 
moment we changed its read status to read. As a result, read messages remain in the 
Unread folder for at least one hour and less than two hours, then automatically 
disappear. This can be disabled by going to Tools | Options | Miscellaneous tab. 

I get a startup message about my default email prog ram 

For some versions of Outlook, NEO requires that Microsoft Outlook be configured as 
your default email program. NEO detects this and reports it to you each time you start 
NEO. Ensure "Microsoft Outlook" is your default email program. To change the setting: 
click Start, point to Settings, click Control Panel, then double-clicking the Internet 
Options icon. Click the Programs tab, then choose Microsoft Outlook as the E-mail 
program. Do not choose Outlook Express.. 

It could be that NEO will work well for you even if you get this message. If  NEO does 
work for you, you can disable the message by adding the following key in your registry. 

   HKEY_CURRENT_USER\Software\Caelo\NEO 
Pro\4.0\Options\NoDefaultClientCheck 

as a Dword value set to 1.  This will disable checking on startup. You should be very 
careful when modifying your registry. If you have any questions, please send an email 
to support@caelo.com. 

Why can’t I see my attachment? 

If you have the Microsoft E-mail Security Update installed you will not be able to open 
or save certain file types. Please consult your Microsoft Outlook documentation for 
more information. 

Some messages appear incorrectly addressed to or fr om me, or addresses addressed to me 
appear in Bulk Mail 

Have a look at your addresses. If someone else's address is in your 'your address' list, 
or if all of your addresses are not in there, your email will not show correctly. 

What NEO and Outlook folders is a message in? 

Right-click the message in the list pane then click Message Properties. You will see a 
list of all the views and folders the message is in.  

NEO doesn’t start properly 

NEO will not start and will report errors if email is improperly configured on your 
computer.  
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Some startup problems can also occur because of interaction with other email-aware 
programs you may be running. We can help solve these conflicts. Please contact us. 

Can I delete all messages from a correspondent by d eleting the correspondent folder? 

Yes, but be careful. You will also delete all other messages to which that correspondent 
was an addressee. 

Where do I set my print options? 

Your print options are set in Outlook. However, you can set print options temporarily by 
using Print on the File menu on the open message window.  

How often should I synchronize? 

It depends on how you are using NEO, and on whether you are an Exchange Server 
user. See topic 'Synchronizing with Outlook'. 

How does the NEO Sync differ from Outlook Synchroni ze? 

NEO Sync synchronizes your message store (Exchange mailbox, PST or OST) with the 
NEO catalog (where NEO stores all of its data). 

Outlook Synchronize applies only to Exchange users who have enabled offline access. 
It synchronizes your Exchange mailbox with your offline message store (OST). It is not 
related to NEO's synchronize. 

Can I use a memory drive for my NEO catalog?  

Yes, you can. Especially when having a large Outlook system, a memory drive can 
make NEO’s performance even better by placing its catalog on it. Make sure to use a 
memory drive product which saves and restores its contents upon system 
shutdown/restart. Also in this case make sure the backup location of your NEO catalog 
is on different location than the memory drive to be protected against system or 
memory drive failures. You can define a new backup location on the Catalog Properties 
screen (through the File menu). A memory drive can be safely used as NEO is not 
copying any of your messages but merely keeps references to your messages in its 
catalog which can always be rebuild from backup in case of failures.. 

How do I back up my NEO data?  

NEO automatically backs up critical files for you, and you can backup those catalog 
files manually too. See chapter on Catalogs for more information. 

How do I report a problem? 

Click 'Get Support…' on NEO's Help tab. 

Downloading, Installing, Licensing ... 
Is the trial version of NEO Pro different from the "final" version? 

No. In fact the trial version is the final version. When you purchase NEO Pro we send 
you registration information that you enter into the NEO you first downloaded. Simply by 
entering the registration information, the trial period is removed and you're all set. 

Why do I need a license for NEO Pro evaluation? 

NEO Pro evaluation is free of charge but still requires a license to manage the 
evaluation period. It just takes a few seconds to connect to our server to get a license. 
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No personally identified information is transferred in that process (without your 
permission). 

Do I have to re-download on purchase? 

No. All you need to do is enter the registration information that we email to you. 

How often can I download? 

As often as you like. If you do download more than once, we suggest you use the same 
email address as previously.  

What NEO Pro upgrades do I get for free? 

If you are an unlicensed user you are entitled to download and try out any version of 
NEO provided your trial period has not expired. 

If you are a licensed user you are entitled to all versions of the same major version 
level. For example, if you purchased version 4.0, you are entitled to free upgrades for 
all 4.x versions (e.g. 4.1, 4.2, etc.). 

How do I know I have the latest version? 

Select Help | Check for Updates 

How do I permanently register NEO Pro? 

When you purchase NEO you will be sent registration information and instructions on 
how to register. 

Am I sent the "final" version? 

No we don't send anything except the registration information. The trial version actually 
is the final version. Simply by entering the registration information, the trial period is 
removed and you're all set. 

Do I have to re-register when I upgrade NEO? 

You'll automatically stay licensed if you are upgrading the same major version (e.g., 4.0 
to 4.1).  

If you are upgrading to a new major release (for which we offer an upgrade price), you 
will need to enter new registration information. 

Will I stay licensed if I upgrade my computer? 

See “Buying, Registering and Updating” for more information. 

What if I lose my registration information? 

Connect to our support page online and click the link "Resend License Information".  

Is NEO easy to uninstall? 

Yes. Outlook settings are never changed and all your messages are left intact. By the 
way, Outlook always continues to get messages whether you are using NEO or 
not. See topic "Uninstalling NEO". 
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Reference 
  

Keyboard shortcuts 

  

Main folders 

F8 Go to Inbox 
F11 Go to Active Mail 
F10 Go to To Do folder 
Shift+F10 Go to Flagged folder 

Launching weblinks 

Click link Launch weblink in current browser window 
Shift+Click link Launch weblink in new browser window 

Switching Views within NEO 

Alt+H Switch to Hot view  
Alt+C Switch to Correspondent view  
Alt+B Switch to Bulk Mail view 
Alt+G Switch to Category view   
Alt+U Switch to Status view   
Alt+D Switch to Date view   
Alt+A Switch to Attachment view   
Alt+O Switch to Outlook view 
Alt+S Switch to Search view 
Alt+V Toggle Conversation View on/off 

Organizing and Categorizing Messages 

Ctrl+I File to Quick File folder (or Backspace if so configured) 
Ctrl+Alt+V Display Quick File Recent menu (or Backspace if so configured) 
Shift+Ctrl+V File to folder 
Ctrl+T or Alt+Z Categorize message (open Category Picker)   
Ctrl+Alt+T or Ctrl+Alt+Z Open Category Picker with focus in edit box 
Shift+Ctrl+T Edit category in reading pane   
Shift+Ctrl+F3 Find Category - go to view to set filter 
Shift+Ctrl+E Re-organize Message 
Shift+Ctrl+X Block Spam Sender 

Changing Message Status  

Ctrl+B Edit Subject in Reading Pane 
Spacebar or Ctrl+Q Mark as Read  
Shift+Spacebar or Ctrl+U Mark as Unread 
F12 Make Inactive (or Backspace if so configured)   
Shift+F12 Make Active (or Shift+Backspace if so configured)   
Alt+0 / ` Remove To Do   
Alt+1 To Do - High   
Alt+2 To Do - Normal   
Alt+3 To Do - Low   
Ctrl+G Flag using default Flag 
Shift+Ctrl+G Remove Flag 
Ctrl+K Keep   
Ctrl+P Print 

Message Actions 
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Ctrl+N New Message 
Ctrl+E New Message To Correspondent 
Ctrl+O or Enter Open Message 
Ctrl+R Reply 
Shift+Ctrl+R Reply All 
Ctrl+F Forward 
Del or Ctrl+D Delete (move to Deleted Items)  
Shift+Del Permanent Delete 
Ctrl+S Save message to Drafts (when message is open)  
Ctrl+Enter Send message (when message is open) 
Ctrl+Alt+N Open message Note editor 
Alt+Enter Message properties 

Jumps to other areas 

Ctrl+J Jump to (Correspondent) Folder 
Ctrl+F3 Find Correspondent 
Shift+Ctrl+F3 Find Category 
Shift+Ctrl+F New Search 
Ctrl+Alt+F3 or Alt+X Search in Folder 
Ctrl+Alt+F Search on Conversation   
Ctrl+Shift+O Open Contact 

Folder List 

Ctrl+H Make folder Hot   
Shift+Ctrl+H Remove folder from Hot   
Shift+Ctrl+V File to folder 
Alt+Del Remove folder  (does not delete messages)  
Del or Ctrl+D Delete folder  (deletes messages) 
F2 Rename folder 
Shift+Ctrl+E New folder 
Num + Expand current folder in Folder List 
Num - Collapse current folder in Folder List 
Shift+Ctrl+Num + Expand all folders from anywhere in list 
Shift+Ctrl+Num - Collapse all folders from anywhere in list 

Switching to Outlook 

Ctrl+0 Switch to Outlook current location 
Ctrl+1 Switch to Outlook Inbox 
Ctrl+2 Switch to Outlook Calendar 
Ctrl+3 Switch to Outlook Contacts 
Ctrl+4 Switch to Outlook Tasks 
Ctrl+5 Switch to Outlook Notes 
Ctrl+8 Switch to Outlook Journal 

New Outlook Items 

Shift+Ctrl+A New Outlook Appointment 
Shift+Ctrl+C New Outlook Contact 
Shift+Ctrl+J New Outlook Journal Entry 
Shift+Ctrl+K New Outlook Task 
Ctrl+N New Outlook Message 
Shift+Ctrl+N New Outlook Note 

Working with the List and Reading Pane 

Ctrl + Up or Ctrl + , Move to previous message  
Ctrl + Down or Ctrl + . Move to next message 
Shift+Ctrl +Alt Up/Down Scroll List Pane without changing focus 
Home To first message or start of message 
End To last message or end of message 
Alt+V Toggle Conversation View on/off 
Right Arrow (�) Expand conversation (in Conversation View) 
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Left Arrow (�) Collapse conversation (in Conversation View) 
Alt+Enter Message properties 
 
Ctrl+Alt+Up Reading Pane On 
Ctrl+Alt+Down Minimize Reading Pane 
Ctrl+Shift+Up Increase Reading Pane 
Ctrl+Shift+Down Decrease Reading Pane 
Ctrl+Shift+PageUp Maximize Reading Pane 
Ctrl+Shift+PageDown Restore Reading Pane 

Actions generally available anywhere 

F1 Help 
Ctrl+F3 Find Correspondent - go to view to set filter 
Shift+Ctrl+F3 Find Category - go to view to set filter 
Shift+Ctrl+F New Search 
Ctrl+Alt+F Search on Conversation   
F3 Filter folder names of current view 
F10 Go to To Do folder   
Shift+F10 Go to Flagged folder   
F8 Go to Inbox 
F11 Go to Active Mail   
Shift+Ctrl+B Open Address Book 
Ctrl+L Toggle filter on/off   
Shift+Ctrl+L Clear filter   
Ctrl+M or F9 Send/Receive Mail 
Tab Cycle panes forward (View, List, Reading)  
Shift+Tab Cycle panes backward 
Alt + Left Back to previous folder 
Alt + Right Forward to next folder 
Shift+F11 Reset all Active Mail messages   
Shift+Ctrl+F11 Reset Correspondent Active Mail only   
Ctrl+F11 Reset Bulk Active Mail only   
Ctrl+A Select All 
Ctrl+X Cut 
Ctrl+C Copy 
Ctrl+V Paste 
Shift+Start NEO Starts NEO without opening a catalog 
Shift+Ctrl+Start NEO Starts NEO and resets Workspace and Toolbar back to default 

  

Symbols 

Message status symbols 

 

High Importance (otherwise blank) 

 

Correspondent class  

 

Bulk Mail class 

 Filed to folder 

 

Unread  (Read messages show as blank) 

 

You replied 

 

You forwarded 

 

New or draft 
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Waiting to be sent (in Outbox) 

 

Flagged - Colored (plus 5 other colors) 

 

Flagged - Complete 

 Remove Flag 

 In Active Mail folder 

 

Make Inactive 

 

In Active Mail folder and To Do set   

 

To Do – Low priority   

 

To Do – Normal priority   

 

To Do – High priority   

 

Remove To Do  

 

Kept   

 

Attachment 

  Note attached to message 

  Note and attachment 

 Sent message (otherwise blank) 

 

Digitally signed - Valid 

 

Digitally signed - Invalid 

 

Meeting Request - Sent 

 

Meeting Request - Declined 

 

Meeting Request - Accepted 

 

Meeting Request - Tentatively Accepted 

 

Task Request - Sent 

 

Task Request - Accepted 

 

Task Request - Declined 

 

Delivery Report - Read 

 

Delivery Report - Non-read 

 

Delivery Report - Delivery 

 

Delivery Report - Non-delivery 

 

Delivery Report - Other 

 

Message Recall - Success 

 

Message Recall - Failure 

    

NEO Folder symbols 

 

Folder is Hot flourish (any folder with a red star is Hot)   

 

Active Mail   

 

To Do   
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Flagged  

 

Kept   

 

Unread   

 

Correspondent  

 

Bulk Mail 

 

Spam Senders 

 

Category   

 

Date   

 

Attachment  (various)   

 

Saved Search   

    

Outlook view Folder symbols 

 

User folder 

 

Quick File designated folder 

 

Inbox 

 

Outbox 

 

Sent Items 

 

Deleted Items 

 

Drafts 

 

Junk E-mail 

 

Contacts 

 

Non-email (Calendar, Journal, Notes, Tasks) 

    

Filter symbols 

 

Filter folders with Unread messages  

 

Filter folders with Active messages   

 

Filter Correspondent messages 

 

Filter Bulk Mail messages 

 

Filter Unread messages   

 

Filter Not Filed messages   

 

Filter Active messages   

 

Filter To Do messages   

 

Filter Flagged messages   

 

Filter Exclusive To - you are in To alone   

 

Filter To -  you are in To alone or with others   

 

Filter Cc - you are in the Cc or Bcc alone or with others   

 

Filter received messages   
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Filter sent messages   

    

Toolbar (command) symbols 

 

New message 

 

Print message 

 

Delete message 

 

Reply to message 

 

Reply to All addressees 

 

Forward message 

 

Categories (open category picker)   

 

Send/Receive messages 

 

Block Spam Sender 

 

Address Book 

 

Fast synchronization 

 

Full synchronization 

 

Open Outlook 

 

Find Correspondent 

 

Search for Conversation   

 

New Search 

 

Search in Folder 

 Jump to Folder 

 

Back to previous folder 

 

Forward to next folder 

    

Other symbols 

 

Help 

 Undo 

 Redo 

 

Catalog 

 

Folder Properties 

 

Category   

 

Master Category   

 

Search - Update word index 

 

Search - Save current search   

 

Search - Choose search folder 

 

New Mail - Hot message arrive (in the Tray)   

 

New Mail - Correspondent message arrive (in the Tray) 
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New Mail - Bulk Mail message arrive (in the Tray) 

  Folder List Filter - Tree order 

  Folder List Filter - Alphabetical order 

  Folder List Filter - Recently-used order 

 

Previous message 

 

Next message 

Privacy Policy 

Click http://www.emailorganizer.com/aboutus/privacy.php to browse to our Privacy Policy. 

Trademark Notices 

©  Copyright 2008-2010 by Caelo Software B.V..  All rights reserved  
de Vlasakker 4  5555 LH Valkenswaard  Netherlands 

Caelo, NEO, NEO Find, NEO Email Finder and Nelson Email Organizer  are 
trademarks of Caelo Software B.V. 

Microsoft , Outlook , Exchange , Outlook Express and Windows are either registered 
trademarks or trademarks of Microsoft Corporation in the United States and/or other 
countries. 

 


